COMPASS USER GUIDE

By

The Office of Architectural, Engineering and Construction Applications
Table of Contents

INTRODUCTION TO COMPASS .................................................................................................................. 8

SECTION 1  OFFICE 365 LOGIN INSTRUCTIONS ...................................................................................... 8
  1.1 Office 365 Sign In .............................................................................................................................. 8
  1.1.1 Sign-In Name .............................................................................................................................. 9
  1.1.2 Sign-In Password .......................................................................................................................... 9

SECTION 2  TRUSTED SITES .................................................................................................................... 9

SECTION 3  PROJECT SITE PERMISSIONS .............................................................................................. 12
  3.1 Permissions Groups Defined ............................................................................................................. 12
    3.1.1 Site Owners Group .................................................................................................................... 12
    3.1.2 Site Members Group .................................................................................................................. 13
    3.1.3 Site Contractors Group ........................................................................................................... 13
    3.1.4 Site Visitors Group .................................................................................................................... 13
    3.1.5 Site Permissions Summary Table ............................................................................................. 13
  3.2 Setting up Site Permissions Groups .................................................................................................. 14
    3.2.1 Site Settings Gear ..................................................................................................................... 14
    3.2.2 Site Settings URL ..................................................................................................................... 17
    3.2.3 Restricted Elements .................................................................................................................. 17
  3.3 Accepting an Invitation (External Users) .......................................................................................... 18

SECTION 4  ACCESSING COMPASS ........................................................................................................ 19

SECTION 5  COMPASS LANDING PAGE ................................................................................................ 20
  5.1 Searching for Projects ...................................................................................................................... 20

SECTION 6  PROJECT LANDING PAGE .................................................................................................. 21

SECTION 7  PROJECT DASHBOARD ....................................................................................................... 22
  7.1 Accessing the Project Dashboard .................................................................................................... 22
  7.2 Project Dashboard Contents ............................................................................................................ 23

SECTION 8  PROJECT DETAILS ............................................................................................................... 24
  8.1 Accessing the Project Details Page .................................................................................................. 24
  8.2 Project Details Contents .................................................................................................................. 24
  8.3 Staff .................................................................................................................................................. 25
    8.3.1 Editing Project Staff .................................................................................................................. 25
8.3.2 Project Staff Features ........................................................................................................... 28
8.3.3 Contacting a Member of the Project Staff ............................................................................. 28
8.4 Project Communication ................................................................................................................ 28

SECTION 9 SUBMITTAL/TRANSMITTAL APPLICATION ......................................................... 29

9.1 Approval Matrix .......................................................................................................................... 30
  9.1.1 Approval Matrix Submittal Type Owners .............................................................................. 30
  9.1.2 Approval Matrix CC List .................................................................................................... 31
9.2 Contractor Invitations .................................................................................................................. 32
  9.2.1 Sending an Invitation ......................................................................................................... 32
  9.2.2 Accepting an Invitation ..................................................................................................... 32
9.3 Project Item Number List .......................................................................................................... 32
9.4 Creating a New Submittal in COMPASS .................................................................................. 32
9.5 Submittal Owner / Approver ...................................................................................................... 35
9.6 Process Assignment .................................................................................................................... 35
  9.6.1 Initial Review ..................................................................................................................... 36
    9.6.1.1 Incomplete Submittal .................................................................................................. 36
  9.6.2 Individual Reviewer (Owner / Approver Only) .................................................................. 37
    9.6.2.1 Individual Reviewer – Expedited Approval .............................................................. 37
    9.6.2.2 Individual Reviewer – Standard Review ................................................................... 38
  9.6.3 Assigning Reviewers .......................................................................................................... 38
    9.6.3.1 Due Dates ................................................................................................................... 38
    9.6.3.2 Order of Review ...................................................................................................... 39
    9.6.3.3 Review Complete ...................................................................................................... 39
  9.6.4 Bluebeam Studio Session .................................................................................................... 39
9.7 Using Bluebeam to Review Submittals ....................................................................................... 39
  9.7.1 Bluebeam Studio Session ................................................................................................... 40
    9.7.1.1 Start Bluebeam Studio Session .................................................................................. 40
    9.7.1.2 Work in Bluebeam Studio Session .......................................................................... 41
    9.7.1.3 Review Complete ..................................................................................................... 43
    9.7.1.4 Review and Action Stamps ....................................................................................... 45
    9.7.1.5 Finalize Bluebeam Studio Session ............................................................................ 45
    9.7.1.6 Reconcile Bluebeam Studio Session Comments ........................................................ 45
9.7.2 Checking Out Documents to Bluebeam ................................................................. 45
9.7.2.1 Set-up Bluebeam Administrator Settings ......................................................... 46
9.7.2.2 Checking Out Documents to Bluebeam ............................................................. 47
9.7.2.3 Multiple Users Checking Out to SharePoint ...................................................... 48
9.7.3 Bluebeam Attachment Tool .................................................................................. 49
9.8 Save a Draft .............................................................................................................. 50
9.9 Revise and Resubmit ............................................................................................... 50
9.10 Revising and Replacing a File ................................................................................ 51
9.10.1 Opening and Downloading a File ....................................................................... 51
9.10.2 Revising a File .................................................................................................... 53
9.10.3 Shop Drawings and Working Drawings ............................................................. 53
9.10.4 Replace File ........................................................................................................ 54
9.11 Send Back to Owner .............................................................................................. 56
9.12 Ball-In-Court Status ............................................................................................. 56
9.13 Navigating the S&T Table ..................................................................................... 56
9.14 Complete Submittal ............................................................................................... 57
9.15 Comments ............................................................................................................... 57
9.15.1 Comment Log ..................................................................................................... 57
9.15.2 Comment Pop-Up Windows ................................................................................ 58
9.16 Document Storage ................................................................................................. 58
9.16.1 Document Storage Securities ............................................................................ 59
9.16.2 Version History .................................................................................................. 59
9.17 Delete a Submittal ................................................................................................. 62

SECTION 10 PROJECT MENU .......................................................................................... 63

SECTION 11 DESIGN INITIATED CHANGE ORDERS ..................................................... 64
11.1 Uploading DCOs to COMPASS .............................................................................. 64
11.2 Sharing DCO Documents with Contractors ........................................................ 67
11.3 Revised Sheets – DCO .......................................................................................... 71
11.3.1 MicroStation Processes ..................................................................................... 71
11.3.2 Bluebeam Processes ......................................................................................... 71
11.4 New Sheets – DCO ............................................................................................... 72
11.4.1 MicroStation Processes ..................................................................................... 72
11.4.2 Bluebeam Processes ................................................................. 73
11.5 New Subset Required – DCO .......................................................... 73
11.6 Voiding Sheets ........................................................................ 73
11.7 DCO Special Provisions ............................................................... 73
11.8 DCO Memorandum from Design to Construction ......................... 74
SECTION 12 EXECUTIVE DASHBOARD .................................................. 74
SECTION 13 MS PROJECT SCHEDULE .................................................. 75
  13.1 Software License Requirements .................................................. 75
  13.2 Existing MS Project Schedules ...................................................... 76
  13.3 New MS Project Schedules .......................................................... 76
  13.4 Working with MS Project – Desktop App ....................................... 77
    13.4.1 Configuring MS Project COMPASS Profile ............................... 77
    13.4.2 Opening a Project Schedule ................................................. 79
    13.4.3 Publishing a Schedule .......................................................... 80
    13.4.4 Checking in a Schedule ....................................................... 81
  13.5 Working with MS Project from COMPASS ..................................... 81
    13.5.1 Open MS Project from a COMPASS Project Site ..................... 81
    13.5.2 Edit an MS Project Schedule in the O365 Web App ................ 82
    13.5.3 Publish Updates to an MS Project Schedule ......................... 83
    13.5.4 Open MS Project from COMPASS PWA Site ......................... 83
    13.5.5 Reassigning MS Project Schedule Ownership ......................... 85
SECTION 14 BEST PRACTICES ............................................................ 87
  14.1 Business Processes .................................................................... 87
  14.2 Naming Conventions ................................................................. 87
  14.3 Revising Working Drawings & Shop Drawings .............................. 87
  14.4 Revise and Resubmit Comments ................................................ 87
SECTION 15 FREQUENTLY ASKED QUESTIONS ...................................... 88
  15.1 Computer Requirements ............................................................ 88
    15.1.1 Devices .............................................................................. 88
    15.1.2 Software Requirements ....................................................... 88
  15.2 Maximum File Size .................................................................... 88
SECTION 16 TROUBLESHOOTING ......................................................... 88
16.1 COMPASS Access Troubleshooting Tips ................................................................. 88
16.2 Reset O365 Password ......................................................................................... 89
16.3 Missing Office 365 Apps .................................................................................. 89
16.4 Loading Projects .............................................................................................. 90
16.5 MS Project Button Does Not Work ................................................................. 90
16.6 Bluebeam Studio Sessions ............................................................................. 90
16.6.1 Bluebeam Studio Session Finalization Process ........................................... 90
16.6.2 Bluebeam Studio Session Expiration Date ............................................... 91
16.6.3 Restoring Archived Bluebeam Studio Session ......................................... 92
16.7 Bluebeam / Internet Explorer Integration ....................................................... 95
16.7.1 Edits not saving in COMPASS ................................................................. 95
16.7.2 PDF Documents Not Opening in Bluebeam .............................................. 96
16.8 Incorrect Owner .............................................................................................. 97
16.9 Incorrect Information ..................................................................................... 98
16.10 Following Project Sites ................................................................................ 98

SECTION 17 DATA DICTIONARY – S&T TABLE ...................................................... 99

SECTION 18 SUPPORT ....................................................................................... 100
18.1 Construction District COMPASS SMEs ....................................................... 100
18.2 AEC Applications ........................................................................................... 100

APPENDIX A: TRAINING RESOURCES ................................................................ 101

APPENDIX B: DATA SOURCES AND COMPUTATIONS ...................................... 102

APPENDIX C: MICROSOFT PROJECT .................................................................. 103
A. Microsoft Project File Set Up ........................................................................... 104
B. Basic Microsoft Project Function .................................................................... 109
   i. Scheduling Terminology ............................................................................... 109
   ii. Task Relationships (Predecessors and Successors) .................................. 110
   iii. Adding, Renaming, Indenting or Deleting a Task ...................................... 112
      a. Adding a Task ......................................................................................... 112
      b. Renaming a Task .................................................................................. 112
      c. Outdenting and Indenting ..................................................................... 113
      d. Deleting a Task ...................................................................................... 114
   iv. Adding and Adjusting Durations ................................................................. 116
v. Lead and Lag Times........................................................................................................... 116
vi. Adding Notes and Hyperlinks to a Task ....................................................................... 118
   a. Adding Task Notes........................................................................................................ 118
   b. Adding Hyperlinks to a Task ....................................................................................... 119
C. Tracking the Project........................................................................................................ 120
   i. Baselining the Project ................................................................................................... 120
      a. Re-baselining ........................................................................................................... 121
   ii. Recording Task Progress .......................................................................................... 125
D. Generating Reports and Summaries............................................................................. 127
   i. Standard Reports......................................................................................................... 127
   ii. Custom Reports.......................................................................................................... 129
   iii. Visual Reports........................................................................................................... 130
APPENDIX D: PROCESSING DIGITAL CONTRACTOR SUBMISSIONS ............................. 132
   A. Contractor Submittal Types ........................................................................................ 132
   B. Summary of Review Process and Roles ..................................................................... 132
   C. Coordination and Communication .......................................................................... 135
   D. Process Conclusion .................................................................................................... 136
APPENDIX E: BLUEBEAM 2016 INTEGRATION ................................................................. 137
Introduction to COMPASS

The objective of the COMPASS project is to provide CTDOT with project management processes that work in conjunction with a cloud-based digital Transportation Management Solution, utilizing Microsoft Commercial Off-the-Shelf Software (MCOTS) to manage the delivery of all capital projects. Specifically, this solution will provide improved quality and control over complex transportation projects by providing:

- Ball-In-Court project status
- Better collaboration and communication using SharePoint online
- Real-time project scheduling capabilities using MS Project
- Improved resource management
- Real-time project status dashboards
- Document control and content management
- Improved transparency and accountability
- Improved risk management

Section 1 Office 365 Login Instructions

COMPASS is a cloud-based application built on Microsoft SharePoint ages. Thus, users require an Office 365 (O365) account to access the site. This account provides access to COMPASS as well as many other useful Office 365 applications. CTDOT users are provided with a CTDOT O365 license. External user invitations are sent to non-CTDOT personnel – such as consultants and contractors – to grant project-specific COMPASS site access.

1.1 Office 365 Sign In

The Microsoft Online sign-in page is located at https://www.office.com, or can be found by internet searching for “Office 365 log-in.”
1.1.1 Sign-In Name
For CTDOT personnel, user sign-in names match computer sign-in names and are not the ct.gov email addresses. Sign-in names are typically in the following format:

[Full Last Name] + [First Initial] + [Middle Initial] @dot.ct.gov

Examples: LynchKL@dot.ct.gov, MurphyZ@dot.ct.gov

1.1.2 Sign-In Password
For CTDOT personnel, user sign-in passwords match computer sign-in passwords. If the computer password is changed, the Microsoft Online password is automatically changed.

Section 2 Trusted Sites
It is recommended that users add COMPASS as a web browser trusted site. This needs to be done one time per each user log-in name and per each device. If the trusted sites are not added, when a user tries to access COMPASS the following error message may appear (“Loading Projects…”):

Take the following steps to add the COMPASS trusted sites to Internet Explorer (IE).

1. Open an Internet Explorer browser window.
2. Click on the settings gear in the upper-right hand corner of the window. Select Internet Options.
3. Navigate to the Internet Options Security tab. Click Trusted Sites. Then press the Sites button.

4. In the top field labeled “Add this website to the zone,” input the following three sites:
   https://compassapis-prod.azurewebsites.net
Press Add after inputting each individual site.

5. The site names will now show in the Websites section. Press Close to exit the Trusted sites window.
6. In the Internet Options window, select the Security tab. Check Enable Protected Mode.

7. Press OK to exit the Internet Options window.
8. Close Internet Explorer.

Section 3  Project Site Permissions
The Project Manager (PM) is the owner of the project site, and thus responsible for setting up and maintaining site security settings. If desired, the PM can delegate this responsibility by adding the selected team member(s) to the Site Owners Group. The majority of participants – including consultants and most CTDOT personnel attached to the project – will be granted Member access.

3.1 Permissions Groups Defined
There are four levels of access to each project: Site Owners, Site Members, Site Contractors and Site Visitors.

3.1.1 Site Owners Group
Site Owners have full control of the site. Items can be added, edited or deleted. Site Owners have the ability to grant access to the site to internal and external users and perform several other administrative functions.
3.1.2 Site Members Group
Site Member is the most common classification for individuals attached to a project. Site Members may add items to project libraries and folders and edit information in the Contacts menu. Individuals who need to review submittals and access document folders should be added to the Members group. Construction Contractors should not be added to the Members group; they should be added to the Site Contractors Group. External users included in the Members group do not have access to the Landing, Dashboard and Details pages; they are only able to access the Submittals / Transmittals (S&T) page and project folders. External users invited to join a project Members group should follow instructions for Accepting an Invitation (External Users).

3.1.3 Site Contractors Group
Users in the Site Contractors permissions group have the ability to create new submittals in the COMPASS S&T application and respond to requests to revise and resubmit. Contractors cannot access any of the project folders or the comment log. Contractors are limited to viewing submittals in the Submittals / Transmittals table that a member of the Contractors group created. If multiple members are included in this group, they will see each other’s submittals in the S&T table. The project Contractor(s) should be added to this group. The User Manual for Construction Contractors provides instructions to Contractors on how to accept invitations and use the COMPASS S&T application.

3.1.4 Site Visitors Group
Site Visitors are limited to read-only access. Site Visitors can view project libraries, menu items and documents. Site Visitors cannot add, edit or delete any information from the site. By default, all CTDOT personnel who have a Department issued Office 365 license are members of the COMPASS Visitors group, which grants Visitor access to all projects in COMPASS.

3.1.5 Site Permissions Summary Table

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>Site Owners</th>
<th>Site Members</th>
<th>Site Contractors</th>
<th>Site Visitors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or remove users to site permissions groups</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a submittal</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Replace a submittal in response to an R&amp;R</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Function as a submittal Owner as assigned in the S&amp;T Approval Matrix</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Review a submittal</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access Internal Documents folder</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View submittal documents</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
3.2 Setting up Site Permissions Groups

The site permissions should be assigned when a COMPASS project is first created. Thereafter, the PM or delegated staff member should maintain access privileges as needed. The PM is responsible for adding and removing members of the COMPASS site permissions groups throughout the duration of the project.

There are two techniques available for maintaining site permissions groups.

3.2.1 Site Settings Gear

To access the Site Settings menu via the gear:

1. Navigate to the Project Details page of the chosen project.

2. Navigate to the Submittals/Transmittals page.

3. Navigate to the Wheel in the upper right hand corner of the Submittals/Transmittals page.
4. Select Site Settings

5. Select Site Permissions

6. Select the Members, Owners, Contractors or Visitors permissions group, as appropriate.
7. To add a new member to the group, press New → Add Users

8. To add CTDOT personnel, type and select the correct name into the names / email addresses field. Contact information is automatically sourced from AD Manager. For external users, the email address needs to be inputted manually. Multiple users can be added to a specific site group at one time. By default, an email invitation will be sent to new users that includes an optional personal message typed by the Owner. To avoid sending an email notification to CTDOT personnel, click Show Options and uncheck the box “Send an email invitation.” Email invitations must be sent to external users. Email invitations should not be forwarded between users; a separate invitation should be sent to each person who requires site access. Once the names, email addresses, optional personal message and optional email invitation selection are complete, press Share to add individuals to the selected Group.
3.2.2 Site Settings URL

To access the Site Settings menu for any COMPASS project:

1. After logging into COMPASS, a URL address can be used to assign permissions to any project. Only COMPASS Owners and Owners of the specific project may modify the project-specific permission groups. Below is an example of how to enter the URL for Project No. 0134-0148. Replace the project number in the example (shown in red font) with the project number in question. All eight digits and the hyphen must be included:


2. Follow steps 6-8 as described in the Site Settings Gear section to add users to the appropriate permissions groups.

3.2.3 Restricted Elements

Please do not use any of the functionality under the Settings menu.

Please do not use the menu items in the ribbon.
3.3 Accepting an Invitation (External Users)

External users (e.g., Contractors, Consultants, Stakeholders, etc.) invited to join a COMPASS project site will need to take the following steps to accept a COMPASS invitation. **External users should never forward their invitations to other users.**

If other individuals need access to a COMPASS project site, a request should be sent to the PM.

*Note: Depending on the user’s email settings, the email notification may route to the SPAM or Junk folder.*

1. The external user will receive an email invitation with a direct link to the project page.

2. On the SharePoint Online invitation acceptance page,
   a. External users with an existing work / company Office 365 account should click Organizational Account and log-in using their company Office 365 user name and password.
   b. External users with an existing personal Microsoft account as described should select “Microsoft account” and sign-in.
   c. External users without an existing Microsoft account should select “Create a Microsoft account” and follow the steps to set-up a new, free account.
Section 4  Accessing COMPASS

For CTDOT users, after following the Office 365 Login Instructions, navigate to SharePoint, then search for the COMPASS site. This location can also be reached via the following URL: https://ctgovdot.sharepoint.com. The first project shown in the list will be highlighted by a blue bar and display the Landing Page information in the center and right sections of the page.
Section 5  COMPASS Landing Page

5.1 Searching for Projects
Once within the COMPASS site, search or filter by Project Number, Project Name, Project Manager or Schedule Phase.

- When searching by Project Number, the hyphen and full eight-digit number should be used, including leading zeroes (####-####).
- Multiple Project Managers and / or Schedule Phases can be selected at the same time.
- Click Reset Filters to clear all filters and begin a new search.

![Filter/Search Projects Arrow](image)

- Click the Filter / Search Projects arrow to collapse or expand the filtering section.

- If a search produces multiple results, scroll between the project Landing Pages by using the up and down arrows located on the upper-right hand side of the page.

## Section 6  Project Landing Page

The following resources can be accessed from each Project Landing page:

1. Project Dashboard
2. Project Details
3. Copy Project URL – Copies the project site URL to the clipboard.
4. **MS Project Schedule** – The MS Project schedule button will only be active if there is an associated schedule and if the user has an MS Project Online license. See [Software License Requirements](#) for details.

The following information resides on each Project Landing page:

- Project Description
- Schedule details including number of tasks remaining, overall schedule health and current Schedule Phase
- Permit and ROW status
- Location map showing the project polygon – Refresh the page to reset the map to its original position.
- Key dates for the project – Open in CORE and FDP
- Staff assigned to the project with their contact details
- Budget donut graphs – Roll over the graph sections to view monetary details
- Funding data

## Section 7 Project Dashboard

### 7.1 Accessing the Project Dashboard

The Project Dashboard can be reached from the Project Landing page, Project Details page, or Submittals / Transmittals page by clicking the Project Dashboard button.
7.2 Project Dashboard Contents

The following resources can be accessed from the Project Dashboard:

1. Project Menu
2. Project Details
3. Submittal/Transmittal Application
4. Back to Project List button

The following information resides on each Project Dashboard:

- Project Description
- Project Value – roll over graph sections to view monetary details
- Project Schedule FDP dates – obligation date, MS Project Schedule date and the associated delta
- Project Expenditures Graph (PEG) (under construction)
- Permitting status
- Rights of Way status
- Location map showing the project polygon – Refresh the page to reset the map to its original position.

## Section 8  Project Details

### 8.1 Accessing the Project Details Page

The Project Details page can be reached from the Project Dashboard, Project Landing page or Submittals / Transmittals page by clicking the Project Details button.

### 8.2 Project Details Contents

The following resources can be accessed from the Project Details page:

1. [Project Menu](#)
2. [MS Project Schedule](#) – The MS Project schedule button will only be active if there is an associated schedule and if the user has an MS Project Online license. See [Software License Requirements](#) for details.
3. Back to Project List button
4. [Staff](#) assigned to the project with their contact details, including the ability to edit.
The following information resides on each Project Details page:

- Town(s)
- Project Description
- Schedule details including number of tasks remaining, overall schedule health and current Schedule Phase
- MS Project schedule milestone details
- Permitting and ROW details
- Budget donut graphs – Roll over the graph sections to view monetary details
- Funding data

8.3 Staff

The Engineering Lead Unit, Engineering Support Units and Construction Districts are responsible for entering and maintaining project staff information in COMPASS. Each Unit and District is to decide which employee(s) are responsible for entering and maintaining the project staff; all CTDOT COMPASS users have the ability to perform this function. Staff information is found on the right-hand side of the Project Landing and Details pages. When this page is correctly populated and maintained, it will provide an authoritative resource of all project staff including Engineering Lead Unit, Engineering Support Units, Consultant staff, Construction staff, Construction Consultants and Contractors. Titles, units / companies, email addresses and phone numbers will be readily available to all who have access to the page.

8.3.1 Editing Project Staff

To edit the project staff:

1. Click the Project Details button to navigate to the Project Details page. The Details button can be accessed from the Landing page, Dashboard or Submittals/Transmittals page.
2. Click Edit in the Staff section of the Details page.

3. Add all project staff to the page. Press Show and Hide to expand or conceal the different staff categories.
   a. **Engineering Lead Unit Staff**: Only one CTDOT unit is to be added to this section. The Transportation Supervising Engineer (TSE) should be the highest level employee added to this section. Unit, title and contact information will automatically populate once a name is added.
   b. **Engineering Support Unit Staff**: All CTDOT engineering support staff are to be added to this section by their respective units. Unit, title and contact information will automatically populate once a name is added.
   c. **Consultant Staff**: All design consultant staff are to be added to this section by the Engineering Lead Unit. Since this section is comprised of external users, all information needs to be manually entered.
   d. **Construction Staff**: All CTDOT construction staff are to be added to this section by the Construction District. Unit, title and contact information will automatically populate once a name is added.
   e. **Construction Consultant Staff**: All construction consultant staff, such as CE&I, are to be added to this section by the Construction District. Since this section is comprised of external users, all information needs to be manually entered.
   f. **Contractor Staff**: All project contractors are to be added to this section by the Construction District. Since this section is comprised of external users, all information needs to be manually entered.
8.3.2 Project Staff Features
The Staff page has several built-in, automated features, including:

- **Engineering Lead Unit Staff:** The Engineering Lead Unit Staff section will populate the lead unit header based on the personnel inputted in this section. Only CTDOT personnel from one unit should be included in this section.

- **Auto-sort by sub-section:** Users are to add personnel into the appropriate category on the Edit Project Staff page. When the changes are saved, COMPASS will automatically sort personnel by sub-section in all categories except Engineering Lead Unit Staff. For Engineering Support Unit Staff, sub-groups such as Bridge State Design and Highway Consultant Design will be created. For Construction Staff, sub-groups will be created based on Construction District. For the three sections containing non-DOT users, COMPASS will sort individuals by company name.

- **Auto-sort hierarchy:** For the three categories containing CTDOT personnel, COMPASS will automatically sort individuals by rank. This is not a direct chain of command listing; rather, COMPASS will sort staff by title within each sub-section.

8.3.3 Contacting a Member of the Project Staff
To contact a member of the project staff, either click on the email address listed to open a new email window or utilize the phone number provided.

8.4 Project Communication
The Project Communication window operates as a message board. It is a location where members of the project team can post messages, updates or other communications to the rest of the team.

To create a new message, type in the New Communication box and click post.

To respond to a Communication thread, click the Reply button associated with the relevant communication and insert text.
Project Communication messages can be searched by typing a keyword or phrase in the Search bar.

**Section 9  Submittal/Transmittal Application**

At its conception, the Document Submittal / Transmittal Application (S&T) was designed as a construction application to be used by Construction staff to track and route Contractor submittals during the construction phase. Its purpose has since expanded to enable anyone to submit, track and store any document type during any project phase. This application allows users to route documents for review or approval. A single or multiple reviewers can perform a review in series or in parallel. Ball-In-Court statuses automatically update for tracking. Routing is performed using document attributes and a project submittal-type approval matrix. Key benefits of the application include:

- One storage location for all documents on the cloud, accessible to anyone with an internet connection
- More transparent and efficient processes
- Automated Ball-In-Court statuses for tracking submittals
- Automated notifications
- Automated reminders
- Automated document version control
- Automated storage
- Routing all project documents for review or approval
• Bluebeam Studio Session integrated for PDF digital review and application of Review and Action Stamps
• PDF Checker for Contract Plans (UC – Under Construction)

9.1 Approval Matrix

The Approval Matrix is used to route documents to the appropriate submittal Owner and provide optional notifications to members of a CC list. The Approval Matrix primarily includes submittal types most likely to be submitted by Contractors to the CTDOT or its consultants.

9.1.1 Approval Matrix Submittal Type Owners

The Engineering Project Manager and Construction Project Manager are jointly responsible for setting up the Approval Matrix. The PMs assign the party responsible for reviewing and approving each submittal type. To be added to the Approval Matrix, an individual first has to join the project site as a Site Member or Site Owner (see Setting up Site Permissions Groups). After the Submitter / Contractor classifies a submittal, the COMPASS S&T application automatically routes the documents to the appropriate submittal owner based on the Approval Matrix. If the Approval Matrix is not complete, by default submittals will be routed to the PM as specified in the Composite Project Database (CPD).

To edit the Approval Matrix:

1. From the Project Landing page, navigate to Project Details.

2. Navigate to the Submittals/Transmittals page

---

Issued November 2019            Version 1.0            Page 30 of 140
3. Open the Approval Matrix by selecting the Approval Matrix button, located next to the New Submittal button.

![Approval Matrix button](image)

4. Assign DOT or Consultant staff to each Submittal type in the “To” column. Save when complete.

<table>
<thead>
<tr>
<th>DOT STAFF</th>
<th>TO</th>
<th>SUB TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for name...</td>
<td>Shop Drawing - Highways</td>
<td></td>
</tr>
<tr>
<td>Search for name...</td>
<td>Shop Drawing - Bridge</td>
<td></td>
</tr>
</tbody>
</table>

### 9.1.2 Approval Matrix CC List

In addition to assigning the required Owners, PMs may create an optional CC list for each submittal type. To be added to the Approval Matrix CC list, an individual first has to join the project site as a Site Member or Site Owner (see Setting up Site Permissions Groups). CC emails are for information only; individuals who are added to a submittal type CC list have no action and are not granted any special privileges or access rights. They will receive an email notification each time the following actions take place on a given submittal type:

- New submittal created (Process Assignment)
- Submittal marked as Revise and Resubmit
- File(s) replaced in response to a Revise and Resubmit (Process Assignment)
- Submittal marked Complete

Users are also able to monitor these actions by accessing the S&T table directly without receiving a CC email notification.
Connecticut Department of Transportation – COMPASS User Guide

<table>
<thead>
<tr>
<th>UNIT</th>
<th>CC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highways</td>
<td>Search for name...</td>
</tr>
<tr>
<td>Bridge</td>
<td>Search for name...</td>
</tr>
</tbody>
</table>

### 9.2 Contractor Invitations

The CTDOT Construction Project Manager (Project Engineer or Chief Inspector) is responsible for inviting the Contractor to join the project site. If a contract has multiple project numbers, the Contractors need to be sent a separate invitation for each project number.

#### 9.2.1 Sending an Invitation

To invite a Contractor to the project site, follow the steps described in Setting up Site Permissions Groups. Invite the Contractor to the xxxx-xxxx Contractors permissions group.

#### 9.2.2 Accepting an Invitation

See Accepting an Invitation (External Users) for information on how to accept a Contractor invitation.

### 9.3 Project Item Number List

The item number list provided in the S&T application is customized for each project. New item numbers can be created by using the “Add New Item Number” tool, as described in Creating a New Submittal in COMPASS.

### 9.4 Creating a New Submittal in COMPASS

The COMPASS S&T application is used to process any type of document throughout the duration of construction. Each submittal must contain the same type of document. For example, a submittal may contain only Bridge Shop Drawings, or only Highway Shop Drawings, but not both. A submittal can contain a single document or multiple documents.

To create a new submittal in COMPASS:

1. Log-in to COMPASS.

2. Select New Submittal on the Submittals/Transmittals page.
3. The Submittal window opens. Complete the appropriate form details:
   a. **Submittal Name:** Follow recommended [Naming Conventions](#) prescribed by CTDOT Construction.
      
      **Note:** Submittal and file names should not exceed 50 characters in length.
      Characters include letters, numbers, symbols and spaces.
      **Note:** Submittal and file names should not contain any of the following restricted characters: ~“#%&*:<>?/\{|}|
   b. **Item Number (optional):** Select one or more Item Numbers associated with the submittal.
      If the Item Number is not listed, take the following steps to add a new number to the drop-down list. Once the new number is generated, it will be added to the drop-down list. It can be selected for the current submittal and will be saved for use in future submittals.
c. **Submittal Type**: Select the appropriate submittal type. This selection will determine to whom the submittal will be routed, based on the project Approval Matrix. It is important to select the correct Submittal Type to ensure there is no delay in routing the submittal to the appropriate person.

d. **Urgent box (optional)**: *The urgent box should be used sparingly.* All submittals marked as urgent will be pinned to the top of the Submittals/Transmittals table. Marking this box does not modify any contractual obligations. This box can be used to highlight a submittal that would benefit from an expedited review.

4. Once the submittal form is prepared, drag the file(s) into the Attach File(s) box or left click and Browse to select file(s). Once attached, the file name can be edited if needed. Press Submit when all Submittal information is complete.

**Note**: Submittal and file names should not exceed 50 characters in length. Characters include letters, numbers, symbols and spaces.

**Note**: Submittal and file names should not contain any of the following restricted characters: ~“#%&*:<>?/\{}

**Note**: The maximum size of individual files is 250 MB. Files in excess of 250 MB can be broken into separate file attachments and included in the same submittal.

**Note**: The files should not be locked or restricted for editing (e.g., PDF/A-1A).

5. The Owner / Approver and any members of the optional CC list will receive an email notification regarding the new submittal. The submittal will populate in the Submittals/Transmittals table, showing the submittal name, type and item number (as inputted by the Contractor). The Review Status will show as Process Assignment with the Ball-In-Court assigned to the Owner.
9.5 Submittal Owner / Approver

When a new submittal is processed, the Owner will be assigned based on the Approval Matrix. For example, if the Submitter / Contractor selects Shop Drawing – Bridge as the Submittal Type, then the person assigned to review Shop Drawing – Bridge in the Approval Matrix for the given project will be assigned as submittal Owner. The submittal Owner is responsible for starting the workflow, reviewing the submittal, initiating a Bluebeam Studio Session (optional), assigning additional reviewers (optional), setting due dates in conformance with any contractual obligations, providing any feedback to the Submitter / Contractor and completing the submittal process.

9.6 Process Assignment

The individual assigned as Owner is responsible for viewing the Submittal Process Assignment page. To access the page, click on the Submittal Name or Review Status (Process Assignment) in the Submittals/Transmittals table.
9.6.1 Initial Review
Before starting the workflow, the submittal Owner should perform an initial assessment of the submittal documents. By clicking on the document link, the Owner can examine the documents in a read-only PDF viewer.

- If the submittal is acceptable for review, please go to Individual Reviewer (Owner / Approver Only) for instructions.
- If the submittal is incomplete, please go to Incomplete Submittal for instructions.

9.6.1.1 Incomplete Submittal
If the Department deems a submittal incomplete or unacceptable, the Owner will send the submittal back to the Submitter / Contractor before beginning a review session. In such a case, the Owner should only push the Revise and Resubmit button and should not hit the Start button. When a submittal is sent back as incomplete, the submittal has not been entered into CTDOT processing; the review process and any associated timeframe requirements have not begun.

Reasons for returning an incomplete submittal before beginning a review session may include, but are not limited to:

- Document Submittal form incorrectly filled out (e.g., incorrect Submittal Type or Item Number is selected)
- Required digital signatures / contractual obligations are missing
- Document Submittal Type incorrectly selected, causing the submittal to route to the incorrect approving party. *Note: An individual who incorrectly receives a submittal should respond to the Submitter / Contractor promptly with instructions to select the correct Submittal Type when resubmitting.*

TO SEND BACK AN INCOMPLETE SUBMITTAL, **DO NOT PRESS START.** PRESS REVISE AND RESUBMIT.
Below is a sample email notification back to the Submitter / Contractor. Comments typed in the Resubmit Comments window will populate in the email notification.

9.6.2 Individual Reviewer (Owner / Approver Only)

9.6.2.1 Individual Reviewer – Expedited Approval

An expedited approval optional is available to an individual reviewer if all of the following conditions are met:

- No other reviewers are needed
- No Bluebeam Studio Session or document mark-ups are needed
- The submittal can be accepted and completed as-is with no need for a Revise and Resubmit process.

If such conditions are met, from the Submittal Process Assignment page, the submittal Owner may push the Bypass Approval & Complete button.
When the Bypass Approval & Complete button is selected, the Review Status automatically updates to Complete and the appropriate notification is sent to the Submitter / Contractor.

### 9.6.2.2 Individual Reviewer – Standard Review

For the Owner to review a submittal as an individual reviewer, enter the appropriate due date, then press Start at the bottom of the Submittal Process Assignment page. This will begin the review workflow.

The status in the Submittals/Transmittals table will update to In Review with the Ball-In-Court the Owner’s name. The Owner then returns to the submittal page and reviews the submittal document(s). If needed, the submittal Owner can add mark-ups or comments by initiating a Bluebeam Studio Session or Checking Out Documents to Bluebeam. When the review is finished, the submittal Owner shall return to the submittal as Revise and Resubmit or Complete, as appropriate.

### 9.6.3 Assigning Reviewers

The Submittal Owner determines whether additional reviewers are necessary. To assign reviewers, press the Add Reviewer button. A list of potential reviewers will automatically generate as letters are typed in the field. Individuals must be belong to the Members or Owners site permissions group in order to participate in a review.

#### 9.6.3.1 Due Dates

The Submittal Owner is responsible for assigning Due Dates to all reviewers (including oneself). The Submittal Owner is responsible for selecting dates that will ensure the submittal review process is
complete within the required timeframes as set by the contract documents. The Submittals/Transmittals table lists the Final Due Date and shows icons to indicate approaching deadlines (e.g., Due within 7 days, Urgent, Past Due, etc.)

### 9.6.3.2 Order of Review
The Submittal Owner can assign reviewers to review the Submittal in series or in parallel. To assign reviewers in parallel, set the Order of Review to the same number. By default, the Submittal Owner is the final reviewer. To assign reviewers in series, set the Order of Review as desired. Any combination of review order can be established by the submittal Owner. If the Owner must remove a Reviewer, click the trash can icon to the right side of the Order of Review column.

![Order of Review Screenshot]

**SET THE ORDER OF REVIEW TO THE SAME NUMBER TO REVIEW IN PARALLEL**

### 9.6.3.3 Review Complete
For instructions for completing an individual review, see [Review Complete](#).

### 9.6.4 Bluebeam Studio Session
If a submittal contains documents in PDF format, the submittal owner has the option to start a Bluebeam Studio Session during the Process Assignment. Starting a Bluebeam Studio Session allows multiple individuals to review a document and enables reviewers to provide mark-ups and review stamps to be returned to the Submitter / Contractor. See [Using Bluebeam to Review Submittals](#) for details.

### 9.7 Using Bluebeam to Review Submittals
Bluebeam is integrated into COMPASS, allowing for single or multi-person reviews as well as application of stamps and digital signatures. The digital review process is consistent with current business practices as delineated in Section 4 of the [CTDOT Digital Project Development Manual](#). There are two techniques for using Bluebeam in COMPASS.
9.7.1 Bluebeam Studio Session

Submittal owners can start a Bluebeam Studio Session directly through COMPASS. In order to initiate a Bluebeam Studio Session, the owner must have a Bluebeam Studio account. If a submittal owner does not have a Bluebeam Studio account, contact AEC Applications to request a free account.

9.7.1.1 Start Bluebeam Studio Session

The Owner is responsible for starting a Bluebeam Studio Session, if needed. If the submittal Owner is unavailable, other project Owners may start a Session via the Edit page. This can be done during two different phases of the workflow:

- Before starting the workflow, on the Submittal Process Assignment page, the Owner can select the Start Bluebeam Session link located under the preferred document. Clicking the file name itself without starting a Bluebeam Studio Session will open the document in a PDF viewer.

- If the workflow has already started and the submittal Owner would like to start a Bluebeam Studio Session, from the Submittal Status Review page select Edit, then select Start Bluebeam Session in the same manner as shown above. In the event that the submittal Owner is unavailable to start a Session, members of the project Site Permissions Owners group can use the Edit function to start a Bluebeam Studio Session.
Each Bluebeam Studio Session hosts only one document. Thus, if multiple documents in a given submittal need to be reviewed in Bluebeam, a separate Bluebeam Studio Session must be started for each individual document.

9.7.1.2 Work in Bluebeam Studio Session

Any documents linked to a Bluebeam Studio Session will show a small icon to the right of the document link, as shown below.
Once a Bluebeam Studio Session starts for a given document, when reviewers (including the Owner) click on the document link, they will automatically be routed to the associated Bluebeam Studio Session. The user will be prompted to enter a user name and password. Reviewers are not required to have a Bluebeam Studio account in order to access the session. This is only required for the Owners who are starting a Bluebeam Studio Session.

If the below message pops up, click Open URL:Bluebeam Protocol.

In the Bluebeam Studio Session, select the document to be reviewed.
Review, mark-up, stamp, comment or insert attachments as needed. The digital review process should be conducted in a manner consistent with current business practices as delineated in Section 4 of the CTDOT Digital Project Development Manual. When complete, individual reviewers should close the Bluebeam window. **Note: Users should not press the Finalize button from within Bluebeam. The Studio Session should be finalized via COMPASS. See Bluebeam Studio Session Finalization Process for details.**

### 9.7.1.3 Review Complete

When one or more reviewers is assigned to a submittal, each reviewer should perform the following steps when the review is complete:

1. Navigate to the submittal through the COMPASS S&T table.

   ![Submittal Review](image)

2. The Submittal Status Review window will open. The current reviewer’s name will be highlighted in blue in the Submittal Reviewer(s) table. The eye icon identifies ball-in-court.
3. Press the gray Complete button to finish the review. The button will turn green and COMPASS will automatically advance to the next assigned reviewer(s).
9.7.1.4 Review and Action Stamps
To apply Submittal Review and Action Stamps in the Bluebeam Studio Session, the user shall first ensure that standard Department settings and stamps are installed. Details for installing the stamps are included in Appendices A and D of the CTDOT Digital Project Development Manual.

9.7.1.5 Finalize Bluebeam Studio Session
The Submittal Owner is responsible for starting and finalizing all Bluebeam Studio Sessions at the appropriate time. When the Owner determines that a Bluebeam Studio Session is complete, the Owner should push the Finalize Bluebeam Studio Session button in COMPASS. This button needs to be pushed for each individual document opened in a Bluebeam Studio Session. If the submittal Owner is unavailable, any person in the site Owners group can finalize the Session via the Edit page. When a Bluebeam Studio Session is finalized, the new document version is automatically saved in COMPASS. Previous versions are preserved through the COMPASS Version History feature. Note: Users should not finalize the Bluebeam Studio Session directly within Bluebeam. The Studio Session should be finalized via COMPASS as described in this section. For more details see Bluebeam Studio Sessions.

9.7.1.6 Reconcile Bluebeam Studio Session Comments
During a Bluebeam Studio Session, comments may be added to the submittal documents that are confidential to CTDOT personnel or Consultants and not appropriate to send to the Submitter / Contractor. After a Bluebeam Studio Session is finalized, the Owner is responsible for reviewing the document and determining whether any mark-ups need to be removed before responding to the Submitter / Contractor. If necessary, the Owner may open Bluebeam without launching a new Studio Session by Checking Out Documents to Bluebeam. This technique can be used to reconcile comments and scrub the document as needed before it is returned to the Submitter / Contractor.

Once all Bluebeam Studio Sessions for a given submittal are complete, the Owner needs to take final action to communicate with the Submitter / Contractor. If no further is action required by the Submitter / Contractor, the Owner should press Complete in COMPASS to end the submittal workflow; a notification email will be sent to the Submitter / Contractor automatically. If further action is required, the Owner should press Revise and Resubmit and provide comments to the Submitter / Contractor. These two processes cannot proceed if any Bluebeam Studio Sessions are still open. In such a case, COMPASS will block the process and provide a notification message: “A Bluebeam Studio Session is still open. Please make sure the documents are ready for review by the Submitter / Contractor and close the session before proceeding.”

9.7.2 Checking Out Documents to Bluebeam
Bluebeam has built-in integration with SharePoint. Since COMPASS is a SharePoint site, this integration can be used in COMPASS for a single-reviewer who prefers not to launch a new Bluebeam Studio.
Session or who needs to scrub a document before it is sent to the Submitter / Contractor. This functionality is a recommended option when:

- The Owner is the sole reviewer and prefers not to launch a Bluebeam Studio Session.
- Before returning a submittal to the Submitter / Contractor, the Owner needs to scrub or modify review comments applied during a Bluebeam Studio Session.

This process only works when using Internet Explorer as a browser. The process outlined below applies specifically to Bluebeam 2018. The checking out process should not be attempted while a Bluebeam Studio Session is open.

### 9.7.2.1 Set-up Bluebeam Administrator Settings

To set-up the Bluebeam / SharePoint integration:

1. From the Start menu, open Bluebeam Administrator 2018. (See Appendix E: Bluebeam 2016 Integration for instructions applicable to Bluebeam 2016.)
2. Select the Revu tab
3. Check the Use as Default PDF Viewer box.
4. On the Plugins tab, click Internet Explorer - Revu 2018 and Checkout SharePoint Files on Open. Press Apply. Press OK to close the window.
9.7.2.2 Checking Out Documents to Bluebeam

After setting up the Bluebeam Administrator 2018 settings, perform the following steps to check-out a COMPASS document and open it directly in Bluebeam without starting a Studio Session:

1. Using Internet Explorer, navigate to the correct submittal in the Submittals/Transmittals table.
2. From the S&T table or Internal Documents folder, select the preferred PDF submittal document.
3. The document will open in Bluebeam. The SharePoint check-out symbol will appear on the document tab. The user can then edit, mark-up or scrub the document as needed. Previous versions of the document are preserved by COMPASS’s Version History feature.

4. When complete, press Save in Bluebeam.
5. Close the document by closing the individual Bluebeam tab or closing the entire Bluebeam program.
6. The Close SharePoint Document window will appear. Either the Check In or Release Checkout button must be pressed to return the document to COMPASS.
   - Press Check In to save any mark-ups or edits and return the document to COMPASS.
• Press **Release Checkout** if no changes or edits need to be saved to the document. This option does not save any changes or make a new version.

*Note: Comments inputted in this window will **not** be provided to the Submitter / Contractor. Comments intended for the Submitter / Contractor must be added to the PDF document itself or inputted in the COMPASS **Comment Pop-Up Windows**.*

7. Bluebeam will communicate with SharePoint based on the option selected. If the Check In button was selected, a new version saves in COMPASS. The previous version(s) are preserved through COMPASS’s **Version History** feature.

8. Once the Owner’s review is complete, the Owner needs to take final action to communicate with the Submitter / Contractor. If no further is action required by the Submitter / Contractor, the Owner should press Complete in COMPASS to end the submittal workflow and a notification email will be sent automatically. If further action is required, the Owner should press **Revise and Resubmit** and provide comments to the Submitter / Contractor.

9.7.2.3 **Multiple Users Checking Out to SharePoint**

Only one user can check a file out to SharePoint at a time. If a document is checked out and another individual attempts to check out the same document concurrently, Bluebeam will open and provide the following message:
To identify the user who has a document checked out via the SharePoint feature, users can navigate to the file in the Internal Documents folder. For Contractor Submittals this location is Internal Documents \rightarrow 120_Contractor_Submittals (PDF). The name of the user who has a document checked out will be listed in document’s row under the Checked Out To column:

![Checked Out To](image)

### 9.7.3 Bluebeam Attachment Tool

When using COMPASS, Owners and Reviewers may choose to respond to the Submitter / Contractor with a letter or memo. Such a response can be transmitted via COMPASS using Bluebeam Revu’s Attachment Tool.

To attach a file inside of a COMPASS document:

1. Open the submittal document from COMPASS using a [Bluebeam Studio Session](#) or by [Checking Out Documents to Bluebeam](#).
2. Once the document is opened in Bluebeam Revu, go to Tools \rightarrow File Attachment.
3. An Open Dialog box appears.

![Open From Dialog](image)

4. Browse to and select the desired file to send to the Contractor. Then click Open. *Note: Attachments are made individually, so only one file can be selected at a time. If multiple files need to be attached to a submittal document, then a separate attachment can be created for each file.*
5. Click on the submittal PDF to place the Attachment icon, a paper clip. Attachment icons can be moved after they have been placed. Click and drag the icon to move it. The name of the attachment file is revealed when hovered over with a mouse.
6. When finished inserting attachment(s), finalize the Bluebeam Studio Session or check-in the PDF per the applicable instructions for Using Bluebeam to Review Submittals.

7. If no further action is required by the Contractor, press Complete. If the Contractor has further action or correspondence, press Revise and Resubmit. The Contractor will be able to view and download the original submittal with the response attachment. This response attachment will also automatically save in the Internal Documents version controlled folder in COMPASS. **Note:** If using the Attachment Tool, the submittal Owner should include a note to the Contractor in the Comments box, notifying the recipient that an attachment containing additional information is embedded in the document.

### 9.8 Save a Draft

The Owner, Reviewer and Submitter / Contractor have the option to save their work as a draft without advancing the workflow. In the Process Assignment and Document Submittal windows, if the Save button is selected the user’s work will be saved as a draft. In the Submittals/Transmittals table, the Review Status will show as Draft. The Ball-In-Court will remain with the user who selected save.

### 9.9 Revise and Resubmit

The Revise and Resubmit button in COMPASS is not to be confused with the Department’s disposition, as communicated through the Digital Review and Action Stamps. The nomenclature in COMPASS indicates the submittal review status, **not** the Department’s disposition.

The Submittal Owner should select the Revise and Resubmit button if there is further action that the Submitter / Contractor needs to take before the Submittal can be completed. The Owner should provide comments in the comment pop-up window and / or via mark-ups in the actual submittal document(s) (created Bluebeam). When the Owner selects the Revise and Resubmit button, the Ball-In-Court will update to the Submitter / Contractor, with a Review Status of Revise and Resubmit in the Submittals/Transmittals table.
The Submitter / Contractor is responsible for reviewing all comments and mark-ups and resubmitting the document(s) as needed. If the Owner returns a shop drawing submittal with different dispositions stamped on each sheet, the Submitter / Contractor shall revise individual sheets as needed. When the replacement document is ready to submit, the Submitter / Contractor shall combine into one file the approved sheets and replacement sheets.

The Revise and Resubmit function can be used multiple times, if needed, for a given Submittal. COMPASS has automated Version History so all versions of a given document are saved in the same location and can be readily accessed.

**9.10 Revising and Replacing a File**

When a submittal is returned to the Submitter / Contractor as Revise and Resubmit, the Submitter / Contractor is responsible for opening the document, reviewing all email comments and mark-ups, and responding according to current business processes as described in Section 9 of the CTDOT Digital Project Development Manual.

**9.10.1 Opening and Downloading a File**

To open a file, navigate to the appropriate submittal from the Submittals / Transmittals table. Select the hyperlink in either the Submittal or Review Status column. The Review Status will be listed as Revise and Resubmit; the Ball-In-Court will list the Submitter / Contractor’s user name.

When the hyperlink is selected, the Document Submittal window will appear. This window will appear similar to the original window used to create a New Submittal. The two key differences are that the submittal document(s) will appear and there will be a Replace File link under each document listed. To view the submittal document(s), select the file name.
If the document is a PDF, it will appear in a PDF viewer. From the PDF viewer, the document can be downloaded and saved to the preferred location (e.g., desktop, server, drive, etc.) Examples of how to save from the PDF viewer are shown below. The exact appearance and function vary by device and browser type.
9.10.2 Revising a File

Once the comments provided via email and/or in the document mark-ups are reviewed, the Submitter / Contractor is responsible for revising the submittal document(s). The Submitter / Contractor should not revise any portion of any documents that have been accepted by the Department.

9.10.3 Shop Drawings and Working Drawings

If the Owner returns a shop or working drawing submittal with different dispositions stamped on each sheet, the Submitter / Contractor shall revise individual sheets as needed. Consistent with current business processes, the Submitter / Contractor shall only make modifications to sheets stamped Revise and Resubmit or Rejected; the Submitter / Contractor shall not make any modifications to sheets that have been accepted by the Department. When the replacement document is ready to submit, the Submitter / Contractor shall combine the approved sheets and replacement sheets in the appropriate order in one file.

To combine approved and replacement sheets using Bluebeam Revu, open the document that was downloaded from COMPASS. Then go to Document → Replace Pages, or press CTRL + SHIFT + Y.

An Open From dialog window will appear. Navigate to and select the file that contains the replacement pages.
If the replacement pages are contained in separate files, the above process can be repeated until the new document is compiled. *Note: Documents that have been certified or digitally signed cannot have pages replaced.*

### 9.10.4 Replace File

When the replacement document is prepared, the Submitter / Contractor should:

1. Navigate to the appropriate submittal page and click the Replace File button. *Note: The Submitter / Contractor should not respond to a Revise and Resubmit by attaching a new document in the Attach File(s) window:*

2. A document file window will appear. Select the correct document to upload, then press the Open button. The replacement document does not have to match the original file name; it can have any name necessary based on the Submitter / Contractor’s naming conventions (*e.g.*, Rev. 1, etc.).
3. The File Ready to Replace prompt appears. The file name in COMPASS remains the same, regardless of the name of the replacement file itself.

4. If more than one file in a given submittal is to be replaced, press Replace File under each document and repeat the process described above. Ensure that the correct replacement file is uploaded to replace the corresponding original document in COMPASS.

5. Press Submit to complete the R&R process. COMPASS automatically saves the replacement file in the original document’s Version History. The Ball In Court will return to the submittal Owner.
9.11 Send Back to Owner
If an individual is incorrectly assigned to review a submittal, the assignee should push the Send Back To Owner button to return the submittal to the Owner. A comment should be included explaining the reason for sending back the submittal. This will route the document back to the Owner to assign correctly. Any individual who believes a submittal to have been incorrectly assigned is responsible for sending back the document immediately to avoid any delays to the processing period.

9.12 Ball-In-Court Status
The Submittals/Transmittals table contains a Ball-In-Court column that automatically updates throughout the workflow. The Ball-In-Court will list one or more individuals at a given time during the review process. Once the Submittal is complete, the Ball-In-Court field is blank. All project staff are responsible for monitoring the Submittals/Transmittals table regularly.

9.13 Navigating the S&T Table
The contents of the S&T table can be searched, filtered and sorted for ease of use.

To search or filter, enter key words from submittal names in the search field, or select option from the various drop-down boxes. Press the Reset Filters button to clear all search and filter results.

To sort columns, select the arrow to the right of each column heading. Columns can be sorted in ascending or descending order.
9.14 Complete Submittal

The Submittal Owner is responsible for pressing the Complete button to finalize a review. The Complete button should not be pushed until there is no further action required by the Submitter / Contractor. For example, if a Submittal Review stamp is applied, a submittal should only be completed if the Department’s disposition is “No Exceptions Noted” or “Exceptions as Noted.” The Submitter / Contractor is responsible for opening and reviewing the final submittal documents to determine the Department’s disposition. The Department’s disposition is not shown as a status in the Submittal / Transmittal tool; it will be communicated per the current business processes. *Once a submittal is marked Complete, the action cannot be undone and no further action can take place in the submittal workflow.*

![Complete Submittal Button](image)

9.15 Comments

The COMPASS Document Submittal / Transmittal Application contains two mechanisms for providing comments.

9.15.1 Comment Log

The comment log is accessible to all individuals in the project Site Owners or Site Members groups and can be used for any submittal-related communication. The log can be accessed through any of the Submittal / Transmittal windows (e.g., Submittal Status Review, Submittal Process Assignment, Send Back, Complete, etc.) Click the Comments/Log tab to view all comments provided on a given submittal and write new comments. After a new comment is typed, press Post to log it. All comments are automatically date and time stamped and identify the entrant. The comment log is searchable, and a record of the log saves in each COMPASS project page.

![Comment Log Tab](image)
9.15.2 Comment Pop-Up Windows

Optional comment windows pop-up when the Ball-In-Court is returning to the Submitter / Contractor or when the Send Back button is pushed. The Owner or Reviewer completing a given process can use the comment field to communicate with the recipient. Once the comment is typed in the pop-up, press Submit to log it. These comments will populate in the email notification sent to the recipient and be saved in the Comment Log to maintain a record of project communication.

9.16 Document Storage

The Internal Documents section is a SharePoint library attached to each project. To access the Internal Documents library, navigate to the Project Dashboard, Details or Submittals/Transmittals page of the selected project.
By default, all Contractor submittals are saved to the Internal Documents library, in the file named 120_Contractor_Submittals (PDF).

### 9.16.1 Document Storage Securities
All users included in the project Site Owners Group and Site Members Group can view the document folders and document versions. Users in the Site Contractors Group are blocked from viewing the document folders.

### 9.16.2 Version History
COMPASS includes automated Version History. Every version of each individual document is automatically saved in COMPASS. This includes the original document as submitted, versions saved from Bluebeam Studio Sessions, versions saved from checking out to SharePoint and replacement files submitted in response to a Revise and Resubmit.
To access all document versions of a Submitter / Contractor’s submittal:

1. Navigate to the project site.
2. Go to the Project Dashboard, Project Details or Submittals/Transmittals page.
3. Select the Internal Documents library on the left-hand side of the page.

4. Select folder 120_Contractor_Submittals (PDF)

5. Navigate to the document. Columns can be sorted by Name, Modified (date) or Modified By. Click the ellipses (three dots) to show the drop-down menu associated with the preferred document, then click Version history.
6. The document Version history shows in a new window. All versions of the document are listed with their associated version number, date and author. Click on any version’s hyperlink to view the version. When a file has been saved back from a finalized Bluebeam Studio Session, it presents as Modified By CTDOT Admin.
9.17 Delete a Submittal

Members of the project Site Owners permission group have the ability to delete a submittal. When this function is exercised, all elements of the submittal are deleted, including:

- Line item in the S&T table
- Back-up document(s) in the Internal Documents folder
- Comments and comment log

Submittals can be deleted when they are in the following workflow stages:

- Process Assignment
- In Review
- Send Back

Submittals cannot be deleted if they are the Revise and Resubmit or Complete workflow status.

To delete a submittal:

1. Select the submittal from the S&T table.
2. If the submittal is in Process Assignment or Send Back status, select the Delete Submittal button located in the lower left-hand corner of the page. If the submittal is In Review, select Edit to see the Delete Submittal option.
3. A Delete Submittal confirmation window will appear. Select Delete to confirm the deletion. Select Cancel to abort the process. *Once the Delete button is selected all documents and data for the submittal will be permanently deleted. This process cannot be undone once the Delete button is selected.*
Section 10 Project Menu

The Project Menu – located on the left side of Dashboard and Details pages – is comprised of the following sections:

- **Contacts**: The Contacts folder can be used to add contact information for project staff, stakeholders, agencies or other relevant users.
- **Internal Documents**: The Internal Documents folder is structured to mirror ProjectWise. Documents routed through the Submittal / Transmittal tool automatically save to pre-allocated Internal Documents subfolders. Users with access can also save and share documents directly through the Internal Documents folder.
- **Documents**: Under Construction. Do not use this folder at this time.
- **Project Emails**: Project-related emails that need to be memorialized can be saved to the Project Emails folder. The contents of this folder are viewable to those with project site access. Highly confidential project emails that require more restricted access should not be stored in this location.
- **Report of Meetings**: The Report of Meetings tab provides a project-specific OneNote notebook. Project staff can use this OneNote to document meeting minutes, or expand its use to record other notes.

When a selection is made from the Project Menu, a new window will automatically open to provide the information. For example, if the Internal Documents item is selected, a new browser window will be created.
Section 11 Design Initiated Change Orders

Design Initiated Change Orders (DCOs) are change order requests in which the designer alters the original contract by:

- A revision to an existing plan sheet(s) or specification(s).
- The addition of a new plan sheet(s) or specification(s).
- The deletion of an existing plan sheet(s) or specification(s).

The creation and management of DCOs shall be as specified in this section.

Contract plans changed or added due to DCOs shall be submitted in a digitally signed PDF discipline subset(s) containing only the added or revised sheets. The original sheets being revised or deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset shall be digitally signed in a digital signature placeholder that is placed in MicroStation as described in Section 5 of the CTDOT Digital Project Development Manual. DO NOT ADD a cover sheet. Once digitally signed the DCO subset(s) shall be submitted to the CTDOT using COMPASS.

11.1 Uploading DCOs to COMPASS

The discipline DCO subsets shall be named as follows when uploaded to COMPASS:

<table>
<thead>
<tr>
<th>Subset Description</th>
<th>COMPASS File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Discipline Subset</td>
<td>04-Traffic</td>
</tr>
</tbody>
</table>
To upload a DCO to COMPASS:

1. Navigate to the relevant project site.

2. Select the Internal Documents folder.

3. Select the 100_Contract_Plans (PDF) folder.

4. Upload files by selecting Upload → Files or using the Drag and Drop function.
The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being revised by DCO shall NOT be modified except when the Engineer of record places a DCO stamp on the revised sheets. This digital DCO stamp crosses out the entire sheet with a red X and adds the following note: “THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy” where “Y” equals the Design Initiated Change Order number. This stamp is placed over digital signatures.

Warning: When placing the stamps, removing the digital signature is not allowed.

For this process see Section 7 of the CTDOT Digital Project Development Manual.

The Index of Revision Sheet(s) located in the 02-Revisions subset shall be updated by the project manager for all DCOs, and submitted as described in Section 7 of the CTDOT Digital Project Development Manual.

A watermark of the signer’s signature; signature only for CTDOT-designed plans; or PE Stamp for Consultant-designed plans shall be placed on all DCO sheets.
Paper copies for all change orders will be requested and sent to all applicable units following Section 3 of the CTDOT Digital Project Development Manual.

## 11.2 Sharing DCO Documents with Contractors

To share a DCO document with a Contractor:

1. Click the ellipses next to the appropriate document. Select Details from the drop-down menu.

2. Select “Manage access.”
3. Select “Grant Access.”

4. In the Grant Access pop-up window that appears, input the Contractor’s email address associated with the COMPASS project. Select “Can view” to grant read-only rights. Press the “Grant Access” button.
5. Select “Share.”

6. Change the Link Settings to “People with existing access.” Press Apply.
7. Insert the Contractor’s email address. Click “Copy Link.”
8. Click “Copy.” Paste the link into the document to be transmitted to the Contractor.

11.3 Revised Sheets – DCO

11.3.1 MicroStation Processes
A note shall be placed directly above the right-hand corner of the title block of the replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy,” where “Y” equals the Design Initiated Change Order number. This note is a level in MicroStation that needs to be turned on and edited.

The areas on the sheet that are being revised shall encircled by a cloud and a numbered triangle shall be placed somewhere on the line of the cloud. A like-numbered triangle shall be placed in the revision block of the changed sheet, accompanied by a description of the revision itself. The revision number is specific to a particular sheet and is specific to the number of times a sheet is changed, including addenda changes. It starts with one and increases by one for each revision or change to the sheet. If a sheet is changed for the first time under DCO #5 then the sheets revision number is 1 NOT 5. If the next time it is changed again is under DCO #7 the revision number becomes 2 not #7.

Details shown on the original sheet, but are no longer required, shall not be deleted but shall only be crossed out with an “X” on the revised sheet. Engineering judgment must be used to produce clear and concise information for the contractor.

If the number of changes to the sheet cannot be clouded in a clear and concise manner, the existing sheet should be voided.

11.3.2 Bluebeam Processes
Sheet numbers for revised plans shall be as follows:

<table>
<thead>
<tr>
<th>Description</th>
<th>Sheet No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Final Plan Sheet</td>
<td>02.25</td>
</tr>
</tbody>
</table>
Drawing numbers shall not be modified on revised sheets.

Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp (Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 5 of the CTDOT Digital Project Development Manual.

### 11.4 New Sheets – DCO

#### 11.4.1 MicroStation Processes

Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline subset, the new sheet shall just be added to the end and numbered sequentially from the previous last sheet of the discipline subset. The total number of sheets noted on the project plans and discipline subsets stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy,” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the title block. This note is a level in MicroStation that needs to be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a discipline subset, the new sheet number shall be the number of the sheet it most closely relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy,” where “mm/dd/yy” equals the month, day and year the change order request was submitted. This note shall be located directly above the bottom right hand corner of the title block. This note is a level in MicroStation that needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number of the new sheet shall be the drawing number of the sheet it most closely relates to followed by (-#). For example, if the new drawing must be placed in the project plans right after drawing number HWY-10, the drawing number shall be HWY-10-1.
11.4.2 Bluebeam Processes

Added sheet numbers shall be as follows:

<table>
<thead>
<tr>
<th>Description</th>
<th>Sheet No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Final Plan Sheet</td>
<td>04.31</td>
</tr>
<tr>
<td>DCO 3</td>
<td>04.31-1.C3</td>
</tr>
<tr>
<td>Previous Addenda Sheet – Added Sheet</td>
<td>03.24.A1</td>
</tr>
<tr>
<td>DCO 4</td>
<td>03.24-1.C4</td>
</tr>
<tr>
<td>Previous DCO – Revised Sheet</td>
<td>02.45.C1</td>
</tr>
<tr>
<td>DCO 2</td>
<td>02.45.C2</td>
</tr>
<tr>
<td>Previous Addenda – Added Sheet</td>
<td>05.14-1A1</td>
</tr>
<tr>
<td>DCO 2</td>
<td>05.14-2.C2</td>
</tr>
<tr>
<td>Previous DCO – Added Sheet</td>
<td>02.45-1.C1</td>
</tr>
<tr>
<td>DCO 2</td>
<td>02.45-2.C2</td>
</tr>
</tbody>
</table>

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet number plus C#, where # equals the Design Initiated Change Order Request number.

<table>
<thead>
<tr>
<th>Description</th>
<th>Sheet No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Final Plan Sheet</td>
<td>04.5</td>
</tr>
<tr>
<td>DCO 1</td>
<td>04.6.C4</td>
</tr>
</tbody>
</table>

11.5 New Subset Required – DCO

New subsets shall be submitted by DCO and prepared the same way as a FDP discipline subset except with the addition of a C# in the sheet numbers and an note placed, directly above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated Change Order number. This note is a level in MicroStation that needs to be turned on and edited. The first sheet of a new subset will be a subset cover sheet containing an index of drawings contained in that specific subset.

11.6 Voiding Sheets

Contract sheets are never deleted. Sheets submitted within final design plan subsets, addenda subsets, or design initiated change order subsets that are no longer needed shall NOT be deleted, but shall be voided by the engineer of record, with a DCO stamp. The voided stamp crosses out the entire sheet with a red X and adds the following note: “VOIDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy,” where “Y” equals the Design Initiated Change Order number.

11.7 DCO Special Provisions

Special provisions shall be created in accordance with the Department’s policies and procedures for Contract Development.
11.8 DCO Memorandum from Design to Construction

A DCO Memorandum from the Designer to Construction shall be prepared for all change orders. This memorandum shall not include any digitally signed DCO plans and / or DCO specifications. The digitally signed DCO plans shall be uploaded into the 100_Contract Plans folder in COMPASS and the DCO special provisions shall be uploaded into the 110_Contract folder in COMPASS. The memorandum shall include the following:

- A detailed description and justifications of the changes requested.
- Identify the funding source, if known.
- A listing of each new, revised, replaced and / or voided plan sheet(s).
- A listing of each new, revised replaced and / or voided special provision(s).
- A list of the changes in the estimated quantities for the project (increase, decrease). The list should also include any item that is new to the project or any item that is deleted as a result of the revised work. Item numbers of items already in the project should be provided. Item numbers for items that are not currently in the contract should be provided if known.
- The estimated increase in cost or credit associated with the change order request.

The DCO Memorandum shall be submitted into the using the COMPASS S&T Application. To properly route the DCO Memorandum via COMPASS, users should perform the following steps:

- The project site owner shall list the Construction District Engineer in the Memorandum submittal type line in the Approval Matrix.
- The designer shall create a new submittal in COMPASS and select Memorandum as the submittal type.
- The Construction District Engineer will review and route the Memorandum as needed once received.

Section 12 Executive Dashboard

The Executive Dashboard provides an overall summary of all active projects. The Executive Dashboard is accessed from the COMPASS Landing Page and any Project Landing page. Select the blue button to view data.
Click on the question mark (?) option in the upper-right hand corner of each section of the Executive Dashboard to determine how each assessment is calculated. For details, see Data Sources and Computations table.

**Section 13 MS Project Schedule**

All Microsoft Project schedules managed in-house are now stored in COMPASS rather than ProjectWise.

### 13.1 Software License Requirements

Project Managers and any individuals who will be actively maintaining an MS Project schedule must have a Microsoft Project Professional desktop application license and a Microsoft Project Online Professional license. Individuals who will be viewing schedules or implementing minor edits in COMPASS require the Microsoft Project Online Essentials license only.
13.2 Existing MS Project Schedules
AEC Applications is coordinating with individual Project Managers (PMs) to migrate all active, existing MS Project schedules from ProjectWise to COMPASS. For questions on the migration process, contact Chris Smith in AEC Applications.

13.3 New MS Project Schedules
To create a new MS Project schedule, follow the instructions provided in Appendix C: Microsoft Project. When the new MS Project schedule is ready to be added to COMPASS, save it to the appropriate Internal Documents → 140_Project_Administration folder in COMPASS.
Once the schedule is prepared and saved in the 140_folder, contact Chris Smith in AEC Applications to have the file linked to the COMPASS pages.

### 13.4 Working with MS Project – Desktop App

**13.4.1 Configuring MS Project COMPASS Profile**

In order to interact directly with schedules stored in COMPASS via the MS Project Professional Desktop Application, set-up the configuration as follows:

1. Open the Microsoft Project Professional desktop application.
2. Click the File tab at the top of the screen.
3. Press Info → Manage Accounts
4. Click Add.
5. In the Account Properties window, enter the information provided below, then press OK.
13.4.2 Opening a Project Schedule

Schedules stored in COMPASS can be opened to view or edit via the MS Project Professional Desktop Application:

1. Open the Microsoft Project Professional desktop application.
2. Choose the COMPASS profile; press OK.
3. Choose Open Other Projects.
4. Under Project Web App, choose COMPASS.

5. Click Browse and choose the desired project schedule from the list. Note: If the Project schedule is not listed, click “Show me the list of all projects.”

6. Click Open.

13.4.3 Publishing a Schedule
To make changes visible to other users in COMPASS, the schedule must be published. To publish an MS Project schedule:

1. Click on File → Info.
2. Click the Publish button.
13.4.4 Checking in a Schedule
When closing out of a schedule or the application, the user will be prompted to check-in the MS Project file. The user must actively check-in the MS Project schedule to COMPASS before each exit.

13.5 Working with MS Project from COMPASS
Microsoft Project Professional is integrated into COMPASS. Project Managers can edit, change, publish and perform other MS Project tasks inside of MS Project from either the Project Web Application (PWA) or MS Project Professional.

13.5.1 Open MS Project from a COMPASS Project Site
To open a schedule via COMPASS, navigate to that project’s COMPASS site. On the Landing Page or Project Details page, select the MS Project Schedule button.
To edit the schedule in the Microsoft Project desktop application, navigate to the task tab, click the down arrow on the Edit button, and select In Microsoft Project. The schedule will then open in the Microsoft Project desktop application.

13.5.2 Edit an MS Project Schedule in the O365 Web App

To open an MS Project schedule in the Office 365 (O365) Web App (PWA), log-in to COMPASS and navigate to the project site. From the project page, select the MS Project button to access the schedule via the PWA. Click the edit button in the project group on the project tab or the task tab. Incorporate edits as needed.

Once edits are complete, click the close button on the Project tab. Select Check it in and then press OK.
13.5.3 Publish Updates to an MS Project Schedule

Publishing a Microsoft Project schedule makes the most current information available to others users.

When a schedule owner is finished making edits and would like the information to be available to other users:

1. Press close on the Project tab.
2. Click on Publish in the Project group on the Task Tab. This saves and publishes the changes.

13.5.4 Open MS Project from COMPASS PWA Site

Users can also manage MS Project schedules directly through the Project Web App (PWA), rather than navigating through specific project site. This can be particularly useful for users who are maintaining schedules for multiple projects.

To open an MS Project file directly via the PWA site:

1. Sign in to Office 365.
2. Click on the Project application button.
3. Locate and select the relevant schedule by project number in the Project Name column.

4. To view and edit the MS Project schedule, ensure that the “Schedule” tab is selected.
13.5.5 Reassigning MS Project Schedule Ownership

To edit an MS Project Schedule baseline (0-5), the user must be assigned as the “Owner” of the schedule. AEC assigns the correct Project Manager when a schedule is added to COMPASS. The current owner has the ability to reassign ownership if needed. If the current schedule owner is unable to perform this task, contact Chris Smith in AEC Applications.

To reassign ownership of an MS Project schedule in COMPASS, the current owner can:

1. Open the relevant MS Project schedule as described above.
2. Enter the Edit Project Details page.
3. Next to the Owner field, click Browse. Select the new schedule owner, then press OK.
4. Clock and check-in the MS Project schedule.
Section 14 Best Practices

14.1 Business Processes
All project staff – including project managers, reviewers, designers, consultants, contractors, etc. – should monitor their COMPASS accounts daily to assess Ball-In-Court statuses and ensure there is no lag in reviewing and routing submittals.

14.2 Naming Conventions
File names should not exceed 50 characters in length. Characters include letters, numbers, symbols and spaces. Submittal and file names should not contain any of the following restricted characters:

~ “ # % & * : < > ? / \ { } |

Submittal names should accurately describe the contents of the submittal.

Individual file document names should be in the following format:

Project Number [###-####] Submittal Type [WD, SD, RFI ###, RFC ###, etc.] [Description]

Examples:

1234-5678 WD Access Platform
1234-5678 SD Exodermic Precast Panel
1234-5678 RFI 001 Structural Steel
1234-5678 Letter from Smith to Jones Winter Work

14.3 Revising Working Drawings & Shop Drawings
If the submittal owner returns a shop drawing submittal with different dispositions stamped on each sheet, the Submitter / Contractor shall revise individual sheets as needed. When the replacement document is ready to submit, the Submitter / Contractor shall combine into one file the approved sheets and replacement sheets.

14.4 Revise and Resubmit Comments
When an submittal owner returns a submittal via the Revise and Resubmit function, comments should be included to focus and guide the revision process. For example, if a submittal contains three documents, two of which are accepted and one of which requires revision, the following details would be appropriate to provide in the pop-up comment box:

Submittal reviewed.
Two of three documents accepted.
One document to revise and resubmit.
Section 15 Frequently Asked Questions

15.1 Computer Requirements

15.1.1 Devices
COMPASS can be accessed through a desktop computer, laptop computer, tablet or mobile phone. The device must have internet access. For details on ensuring access to the COMPASS website, see Trusted Sites.

15.1.2 Software Requirements
COMPASS is a cloud-based application built on Microsoft SharePoint pages. The following software and account requirements are necessary for CTDOT and Consultant users to experience full functionality of the COMPASS S&T application, including reviewing and routing Contractor submittals:

- Office 365 / Microsoft online account
- Project-specific access to COMPASS
- Bluebeam Studio account
- Bluebeam desktop application

15.2 Maximum File Size
SharePoint has a maximum file size of 250 MB. This applies to individual file attachments and documents uploaded directly into the Internal Documents or Documents folders. If a document exceeds this maximum, the user can break it up into multiple documents contained within the same submittal.

Section 16 Troubleshooting

16.1 COMPASS Access Troubleshooting Tips
Below is a list of troubleshooting tips for users to implement if problems are encountered when trying to access COMPASS:

- Confirm the user has the proper permissions to access the project.
- Confirm the correct log-in name and password are used.
- Confirm all Trusted Sites are added.
- Completely sign out of Office 365 and COMPASS, then log back in.
- Press CTRL+F5 to perform a hard refresh on the page.
- Delete the browser history and cache.
- Verify with local IT support that there are no firewalls, securities or other issues that would interfere with connecting to COMPASS.
- Attempt access using more than one web browser.
16.2 Reset O365 Password

**Problem:** I need to reset my Office 365 sign in password.

**Solution:** CTDOT users cannot reset their passwords via the “reset it now” default prompt that comes with O365. See [Office 365 Login Instructions](#) for sign in name and password information.

16.3 Missing Office 365 Apps

**Problem:** When I sign in to Office 365, I do not have any apps.
Solution: Ensure the correct Office 365 Sign In credentials are inputted to access all the applications available with the CTDOT O365 license.

16.4 Loading Projects

Problem: When I log-in to COMPASS, all I see is the COMPASS header and a spinning wheel that says “Loading Projects.”

Solution: Add COMPASS Trusted Sites to Internet Explorer web browser.

16.5 MS Project Button Does Not Work

Problem: When I press the MS Project button in my COMPASS project, nothing happens.

Solution: If the MS Project button does not open a schedule,

1. Confirm with the PM that an MS Project schedule is attached to the COMPASS project site. See Open MS Project from COMPASS PWA Site for instructions.
2. Confirm that the user trying to access the schedule has an MS Project Online license.

Contact Chris Smith in AEC Applications with any MS Project questions.

16.6 Bluebeam Studio Sessions

16.6.1 Bluebeam Studio Session Finalization Process

In order to maintain the Bluebeam integration with COMPASS, Studio Sessions should only be finalized via COMPASS as shown below and described in the Finalize Bluebeam Studio Session section. Bluebeam Studio Sessions should not be finalized directly inside the Bluebeam Studio Session.
16.6.2 Bluebeam Studio Session Expiration Date

A Bluebeam Studio Session created through COMPASS is set to expire by default one month after its creation. If additional time is needed a user can either finalize the Session and launch a new one within COMPASS or extend the Session’s expiration date.
To extend the Session’s expiration date:

1. Click here to expand Studio
2. Click here to expand
3. Click to open Settings

Disable expiration by unchecking here
Modify expiration date here
Click OK to accept changes

16.6.3 Restoring Archived Bluebeam Studio Session

Only the user who started a Bluebeam Studio Session can restore the Session if it becomes archived. The below information is only applicable within 30 days of a Session being archived. Bluebeam fully purges Studio Sessions from its server that have been closed in excess of 30 days.
1) Hover of the document link in COMPASS to identify the Bluebeam Studio Session ID.

2) Navigate to https://studio.bluebeam.com and enter the Session host’s log-in credentials.
3) Locate and click on the archived Studio Session.

![Image of Studio Session page]

4) Change the status to Active, then Update data.

![Image of Status change in COMPASS]

Now the Session can be finalized inside COMPASS and the document in COMPASS will reflect any changes made in the Session.
16.7 Bluebeam / Internet Explorer Integration

16.7.1 Edits not saving in COMPASS

Q: I set-up the integration, but changes are not being saved.

A: Manually map the SharePoint interface. Open Preferences with CTRL+K.
16.7.2 PDF Documents Not Opening in Bluebeam

Q: I set-up the integration and am using Internet Explorer, but PDFs in SharePoint are still opening in the browser instead of Bluebeam.

A: Disable the Adobe Internet Explorer plug-in.
Incorrect Owner

Q: I was incorrectly assigned Owner of a submittal. What should I do?
A: The two most common reasons a submittal is assigned improperly are that the project PM incorrectly completed the Approval Matrix, or the Submitter / Contractor selected the incorrect Submittal type in the Document Submittal page. If this occurs, do not Start the review session. First, check with the PM to ensure the Approval Matrix is properly set-up. If this is confirmed, press Revise and Resubmit; in the comment pop-up box provide instructions to the Submitter / Contractor to select the correct Submittal Type in the drop-down menu.

16.9 Incorrect Information

Q: Information in COMPASS is incorrect. How do I fix this data?

A: Alert the project PM to the incorrect information. Take screen shots if possible. The majority of the data found in COMPASS (e.g., finances, schedules, ROW, etc.) is pulled from source locations such as CORE. The Staff names and Approval Matrix are manually inputted by the PM. If there are errors in the data, the PM needs to correct manually inputted information or request a correction in the data source from which COMPASS is pulling information.

16.10 Following Project Sites

To follow a COMPASS Submittal / Transmittal Pilot Project Site:

1. Navigate to the Submittal / Transmittal page of the given pilot project.
2. In the upper right hand corner of the screen, click Follow.
3. When accessing the SharePoint Online dashboard, the project site will be listed in the Following section. Clicking on the project number will route the user directly to the pilot project S&T page.
## Section 17 Data Dictionary – S&T Table

<table>
<thead>
<tr>
<th><strong>COLUMN HEADINGS</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Submittal</td>
<td>Submitter / Contractor enters manually in the “Submittal Name” field on the Document Submittal Page</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Submitter / Contractor selects from “Submittal Type” drop-down list on the Document Submittal Page</td>
</tr>
<tr>
<td>Item No.</td>
<td>Optional. Submitter / Contractor selects from “Item Number” project-specific drop-down list on the Document Submittal Page. One or more items can be selected.</td>
</tr>
<tr>
<td>Review Status</td>
<td>Updates automatically. Identifies status of the submittal in the workflow. Does not provide the Department’s disposition on the submittal or the documents contained therein.</td>
</tr>
<tr>
<td>Ball In Court</td>
<td>Updates automatically. Identifies the person(s) responsible for taking the next action in the workflow.</td>
</tr>
<tr>
<td>Submittal Date</td>
<td>Auto-populates when the Submittal is first initiated.</td>
</tr>
<tr>
<td>Final Due Date</td>
<td>Owner sets Due Date on the Process Assignment Page</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>REVIEW STATUS COLUMN</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Process Assignment</td>
<td>First status to appear after a new submittal is added. Based on the Approval Matrix, COMPASS automatically assigns the submittal owner to set-up the review process and schedule.</td>
</tr>
<tr>
<td>In Review (# of #)</td>
<td>Shows that the submittal is in review and identifies number of steps in the review series. Submittal Owner is the final reviewer by default.</td>
</tr>
<tr>
<td>Revise and Resubmit</td>
<td>Alerts Submitter / Contractor to requested revisions. Submitter / Contractor to review comments and/or marked-up documents.</td>
</tr>
<tr>
<td>Send Back</td>
<td>Assigned reviewer declines the Owner’s review request and returns the submittal back to the Owner.</td>
</tr>
<tr>
<td>Complete</td>
<td>Review process is complete. Submitter / Contractor to review comments and/or marked-up documents for the Department’s disposition.</td>
</tr>
<tr>
<td>Draft</td>
<td>A submittal is saved in draft form. The submittal has not been advanced in the workflow but is available for the user to edit and process.</td>
</tr>
</tbody>
</table>
Section 18 Support
Please contact AEC Applications for any support needs.

18.1 Construction District COMPASS SMEs

<table>
<thead>
<tr>
<th>District</th>
<th>COMPASS Rep.</th>
<th>Email</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>District 1</td>
<td>Sabrina Pace</td>
<td><a href="mailto:sabrina.pace@ct.gov">sabrina.pace@ct.gov</a></td>
<td>860-258-4668</td>
</tr>
<tr>
<td></td>
<td>Darlene Salokas</td>
<td><a href="mailto:darlene.salokas@ct.gov">darlene.salokas@ct.gov</a></td>
<td>860-258-4644</td>
</tr>
<tr>
<td>District 2</td>
<td>Jim Paul</td>
<td><a href="mailto:jim.paul@ct.gov">jim.paul@ct.gov</a></td>
<td>860-823-3269</td>
</tr>
<tr>
<td></td>
<td>Jeff Hunter</td>
<td><a href="mailto:jeffery.hunter@ct.gov">jeffery.hunter@ct.gov</a></td>
<td>860-823-3275</td>
</tr>
<tr>
<td>District 3</td>
<td>Steve Hebert</td>
<td><a href="mailto:steven.hebert@ct.gov">steven.hebert@ct.gov</a></td>
<td>203-389-3154</td>
</tr>
<tr>
<td>District 4</td>
<td>Jason Cichon</td>
<td><a href="mailto:jason.cichon@ct.gov">jason.cichon@ct.gov</a></td>
<td>203-591-3575</td>
</tr>
<tr>
<td>District 5</td>
<td>Jennifer Sweeney</td>
<td><a href="mailto:jennifer.sweeney@ct.gov">jennifer.sweeney@ct.gov</a></td>
<td>203-401-5170</td>
</tr>
<tr>
<td></td>
<td>Basel Hashem</td>
<td><a href="mailto:basel.hashem@ct.gov">basel.hashem@ct.gov</a></td>
<td>203-401-5169</td>
</tr>
<tr>
<td></td>
<td>Sal Hussein</td>
<td><a href="mailto:shalal.hussein@ct.gov">shalal.hussein@ct.gov</a></td>
<td></td>
</tr>
<tr>
<td>OOC</td>
<td>Doug Harz</td>
<td><a href="mailto:douglas.harz@ct.gov">douglas.harz@ct.gov</a></td>
<td>860-594-2681</td>
</tr>
<tr>
<td></td>
<td>John Rorrio</td>
<td><a href="mailto:john.rorrio@ct.gov">john.rorrio@ct.gov</a></td>
<td>860-258-4643</td>
</tr>
</tbody>
</table>

18.2 AEC Applications

<table>
<thead>
<tr>
<th>Name</th>
<th>Email</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bruce Bourgoin</td>
<td><a href="mailto:bruce.bourgoin@ct.gov">bruce.bourgoin@ct.gov</a></td>
<td>860-594-2760</td>
</tr>
<tr>
<td>John Dudzinski</td>
<td><a href="mailto:john.dudzinski@ct.gov">john.dudzinski@ct.gov</a></td>
<td>860-594-3196</td>
</tr>
<tr>
<td>Julie Annino</td>
<td><a href="mailto:julie.annino@ct.gov">julie.annino@ct.gov</a></td>
<td>860-594-2730</td>
</tr>
<tr>
<td>Chris Smith</td>
<td><a href="mailto:christopher.d.smith@ct.gov">christopher.d.smith@ct.gov</a></td>
<td>860-594-2724</td>
</tr>
<tr>
<td>Lynne Lofberg</td>
<td><a href="mailto:lynne.lofberg@ct.gov">lynne.lofberg@ct.gov</a></td>
<td>860-594-3201</td>
</tr>
</tbody>
</table>
Appendix A: Training Resources

The following resources are available for users to enhance their knowledge in MS Project Online, SharePoint and other Office 365 products.

**MS Project Online:** [https://support.office.com/en-us/article/Projects-Tasks-b9766811-9f5f-4bca-ac9c-202a183a1656#ID0EAABAAA=Projects](https://support.office.com/en-us/article/Projects-Tasks-b9766811-9f5f-4bca-ac9c-202a183a1656#ID0EAABAAA=Projects)

**QuickHelp by Brainstorm:** [www.quickhelp.com/login](http://www.quickhelp.com/login)

  *User name: ct.gov email address*

  *Password: Compass*
## Appendix B: Data Sources and Computations

The following table identifies the data source and / or computation of each item listed below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Data Source(s)</th>
<th>Computation(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Town data</td>
<td>Project Asset Form – “Location Towns”</td>
<td></td>
</tr>
<tr>
<td>Project Description</td>
<td>CORE – “Project Description”</td>
<td></td>
</tr>
<tr>
<td>Project Title</td>
<td>CORE – “Project Title”</td>
<td></td>
</tr>
<tr>
<td>Tasks Count</td>
<td>MS Project Schedule – total number of tasks</td>
<td></td>
</tr>
<tr>
<td>Project Health</td>
<td></td>
<td>Average of Project Schedule and Budget scores</td>
</tr>
<tr>
<td>ROW Expenditures</td>
<td>ViewPort</td>
<td></td>
</tr>
<tr>
<td>Construction Expenditures</td>
<td>ViewPort, Site Manager</td>
<td></td>
</tr>
<tr>
<td>PE Expenditures</td>
<td>ViewPort</td>
<td></td>
</tr>
<tr>
<td>ROW Estimated Budget</td>
<td>ViewPort</td>
<td></td>
</tr>
<tr>
<td>Construction Estimate Budget</td>
<td>ViewPort</td>
<td></td>
</tr>
<tr>
<td>PE Estimated Budget</td>
<td>Obligation Plan</td>
<td></td>
</tr>
<tr>
<td>Schedule Phase</td>
<td>RPM date, Design Approval date, FDP date, CCD date</td>
<td></td>
</tr>
<tr>
<td>Schedule Milestones</td>
<td>MS Project Schedule</td>
<td></td>
</tr>
<tr>
<td>Permits</td>
<td>ESTP</td>
<td></td>
</tr>
<tr>
<td>ROW and Acquisitions Data</td>
<td>IRMS</td>
<td></td>
</tr>
<tr>
<td>Overall Projects Score</td>
<td>Rounded average of all project health scores</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt; 9 = Green / Good</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7-8.9 = Yellow / At Risk</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt; 7 = Red / Poor</td>
<td></td>
</tr>
<tr>
<td>Projects Health</td>
<td>Average of all Project Schedule and Budget scores</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt; 89% = Green / Good</td>
<td></td>
</tr>
<tr>
<td></td>
<td>70-89% = Yellow / At Risk</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt; 70% = Red / Poor</td>
<td></td>
</tr>
<tr>
<td>Budgets</td>
<td>Sum of outstanding projects</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt; 95% = Red / Poor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>80-95% = Yellow / At Risk</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt; 79% = Green / Good</td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td>Average of all past due project milestones</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt; 89% = Green / Good</td>
<td></td>
</tr>
<tr>
<td></td>
<td>70-89% = Yellow / At Risk</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt; 70% = Red / Poor</td>
<td></td>
</tr>
</tbody>
</table>
Appendix C: Microsoft Project

An Engineering working group evaluated several scheduling software options to support the mission statement. Microsoft Project was selected because it offers the following features and advantages:

- Accommodates any number of milestones and tasks (e.g., easily scalable).
- Graphically displays series and parallel tasks.
- Provides baseline and tracking Gantt charts.
- Displays the critical path.
- Link notes and documents.
- Interfaces with Outlook, Excel, SharePoint (including COMPASS) and other Microsoft products.

Microsoft Project shall be used to develop design phase schedules meeting the following minimum requirements:

1. Includes all the activities identified by the Minimum Requirement Schedule Template. More detailed templates and project-specific schedules are encouraged.
2. Baseline schedule.
3. Task Indicator columns are used to link applicable instruction and reference documents.
4. Explanations for changes in task durations are added as task notes.
5. Tracking View / Gantt chart functions are used.
6. Task-level progress is tracked regularly.
7. Files are stored in COMPASS.
8. Microsoft Project files are maintained and current, with projected schedules in accord with the obligation plan.

Base templates were developed by a committee that included Engineering Management and Subject Manager Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs are as follows:

- Bridge Design – Kevin Blasi and David Gruttadauria
- Consultant Bridge Design – Derick Lessard and Marc Byrnes
- Highway Design – Scott Bushee, Jordan Pike and Vitalij Staroverov
- Consultant Design State Roads – Nilesh Patel and Meredith Andrews
- Traffic Projects Design – Barry Schilling and Michael Chachakis
- Facilities Design – Eric Feldblum and Jesse Benson
- Environmental Compliance – David Harms

The SMEs are responsible for developing and maintaining the division-specific project templates and corresponding task libraries in COMPASS. They shall be the first point of contact regarding discipline-specific template and guidance document inquiries and maintenance. The Department has begun a transition to house and maintain all active project schedules in COMPASS. See Microsoft Project in COMPASS for more information on uploading and maintaining schedules via COMPASS.
For questions, suggestions or issues pertaining to Microsoft Project and the Scheduling Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or John Dudzinski (John.Dudzinski@ct.gov) in AEC Applications.

The table below details the minimum tasks included in the minimum requirements template:

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Project XXXX-XXXX</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Initiation</strong></td>
<td></td>
</tr>
<tr>
<td>● Prepare and Submit PPI</td>
<td></td>
</tr>
<tr>
<td>● Prepare and Approve RPM</td>
<td></td>
</tr>
<tr>
<td>● Secure Funding / Authorization</td>
<td></td>
</tr>
<tr>
<td><strong>Preliminary Design</strong></td>
<td></td>
</tr>
<tr>
<td>● Survey</td>
<td></td>
</tr>
<tr>
<td>● NEPA/CEPA</td>
<td></td>
</tr>
<tr>
<td>● Develop PD through Design Approval</td>
<td></td>
</tr>
<tr>
<td>● Design Approval</td>
<td></td>
</tr>
<tr>
<td><strong>Final Design</strong></td>
<td></td>
</tr>
<tr>
<td>● Prepare Semi-Final Design Submission</td>
<td></td>
</tr>
<tr>
<td>● Prepare Final Design Submission</td>
<td></td>
</tr>
<tr>
<td><strong>ROW Coordination</strong></td>
<td></td>
</tr>
<tr>
<td>● Prepare and Submit Final Accepted Property Maps</td>
<td></td>
</tr>
<tr>
<td>● Acquire Properties</td>
<td></td>
</tr>
<tr>
<td><strong>Permit Acquisition Process</strong></td>
<td></td>
</tr>
<tr>
<td>● Permit A</td>
<td></td>
</tr>
<tr>
<td>○ Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>○ Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>● Permit B</td>
<td></td>
</tr>
<tr>
<td>○ Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>○ Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td>● Permit C</td>
<td></td>
</tr>
<tr>
<td>○ Prepare and Submit Permits to Regulatory Authority</td>
<td></td>
</tr>
<tr>
<td>○ Regulatory Authority Review and Issuance of Permit</td>
<td></td>
</tr>
<tr>
<td><strong>FDP</strong></td>
<td></td>
</tr>
<tr>
<td><strong>DCD</strong></td>
<td></td>
</tr>
<tr>
<td><strong>ADV</strong></td>
<td></td>
</tr>
</tbody>
</table>

A. **Microsoft Project File Set Up**

The following steps show how to set-up a Microsoft Project file.

1. Open ProjectWise Explorer by clicking a shortcut or going to Start and searching for ProjectWise Explorer.
2. Double-click on CTDOT and sign in to ProjectWise.
3. Browse to Documents → 04.00 Engineering Libraries → Scheduling Directive. Select the applicable Scheduling Documents folder. The minimum requirement schedule template is stored in the AEC Scheduling Documents (Minimum Req) folder.
4. Right click on the desired schedule and select Copy. Save locally and prepare MS Project schedule.
5. Once the MS Project schedule is ready to transfer to COMPASS, copy the file to the appropriate project’s COMPASS Internal Documents 140_Project_Administration folder.
Press the Upload button or Drag and drop MS Project file to save to COMPASS Internal Documents.
B. Basic Microsoft Project Function

This section presents the following schedule task terminology and functions:

- Scheduling Terminology
- Task Relationships (Predecessors and Successors)
- Adding, Renaming, Indenting or Deleting a Task
- Adding and Adjusting Durations
- Lead and Lag Times
- Adding Notes and Hyperlinks to a Task
- Combining Multiple Projects


i. Scheduling Terminology

The most common scheduling view is the Gantt chart view, which illustrates a project schedule using task names, durations, start and finish dates to the left of the view, and bar charts presenting this information on the right side of the view.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Indicator Column</td>
<td>Present task Notes and Hyperlinks.</td>
</tr>
<tr>
<td>Milestone</td>
<td>A major schedule date, such as an FDP.</td>
</tr>
<tr>
<td>Parent Task</td>
<td>Shown as a grey* bar in default settings. Duration is populated by the Child Tasks.</td>
</tr>
<tr>
<td>Critical Path</td>
<td>Shown in red.* Signifies the task relationships that control major milestone dates.</td>
</tr>
<tr>
<td>Non-Critical Task</td>
<td>Shown in blue.* Signifies sub-tasks that do not control major milestone dates.</td>
</tr>
</tbody>
</table>

*Colors identified in this table and in subsequent sections refer to the default MS Project format selections.
ii. Task Relationships (Predecessors and Successors)

A **predecessor** is a task which has a start or finish date that impacts the start or finish date of another task.

A **successor** is a task which has a start or finish date that is dependent on another task.

There are different ways of defining task relationships. These are:

- **Finish-to-Start**: This is the default dependency in Microsoft Project in which the successor cannot begin until the predecessor is complete. A Finish-to-Start task relationship is denoted by FS, or as the predecessor’s Task ID. A Task ID is found in the column to the far left of the Gantt chart.

  ![Finish-to-Start Diagram](image1)

- **Start-to-Start**: In this relationship the successor cannot begin until the predecessor begins. The successor task can start at any time after the predecessor begins. A Start-to-Start relationship is designated by SS.

  ![Start-to-Start Diagram](image2)

- **Finish-to-Finish**: In this relationship the successor cannot be completed until the predecessor is completed. The successor can be completed at any time after the predecessor is completed. A Finish-to-Finish task relationship is denoted by FF.

  ![Finish-to-Finish Diagram](image3)

- **Start-to-Finish**: In this relationship the successor cannot be completed until the predecessor begins. The successor can be completed any time after the predecessor has started. The Start-to-Finish task relationship is denoted by SF.

  ![Start-to-Finish Diagram](image4)
The schedule should have a Predecessors column where task relationships can be defined. To define a task relationship, enter the Task ID and the Task Relationship in the associated task’s predecessor cell.

For example, in the figure below, the PPI is the predecessor to the RPM task. The PPI must finish before the RPM can start. This relationship is denoted in the RPM process row’s predecessor’s cell as the number 2. The number 2 represents the predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is Finish-to-Start (FS). Since Finish-to-Start is the default task relationship, an abbreviation is not presented unless there are lead or lag times.

If the Predecessors column is not shown in the template, double click in the Add New Column cell and scroll down to or start typing “predecessor.” If Add New Column is not shown, right click on any column label and select Insert Column, then select Predecessors.
iii. Adding, Renaming, Indenting or Deleting a Task

a. Adding a Task
To add a task, right click on the task which will follow the new task and select Insert Task. For example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select Insert Task, as shown below:

1. Right click an existing task to insert a new task directly above

b. Renaming a Task
Tasks can be renamed by double-clicking on the task to be edited. In the pop-up window, select the General tab, then edit the task name. Note: Do not rename the base template tasks shown in bold.
c. Outdenting and Indenting

Outdenting and indenting provide schedule customization. Outdenting moves a task to the left of the task column, while indenting moves a task to the right. Indenting a task makes it a child of the preceding, outdenting parent task. Parent task durations are populated by their accumulative child task durations. Therefore, parent task durations should not be manually entered. To set your task as a child or sub-task, select the row you would like to modify and click the Indent Buttons in the main toolbar area as shown below:
d. Deleting a Task

A user may delete a task if it is irrelevant. MS Project views any tasks entered with a duration of zero as a milestone. Thus, it is recommended that project managers manually delete and revise predecessor and successor relationships as shown below. To delete a task, right click and select Delete Task. **Note: Do not delete the base template tasks shown in bold.**

![Image of MS Project interface showing how to delete a task]

When a schedule is started, the user should remove irrelevant tasks and estimate all other pertinent task durations. **It is critical to note if the task being deleted is a predecessor.** This can be determined by following the lines stemming from a task in the Gantt chart. If a task is erroneous and must be deleted, but it is also a predecessor for other tasks that should not be deleted, then the successor task must be corrected. Failing to update a new predecessor will likely disrupt task connectivity.

For example, if a project does not require a Preliminary Hydraulic Analysis, the task should be deleted. However, the Hydraulics Analysis is a predecessor for the ABC analysis. Therefore, the ABC Analysis’ predecessor task should be updated. In this case, the Utility Coordination task would be the new predecessor.

**Before Task is Deleted**

![Image showing the task before deletion with a new predecessor ID]
After Task is Deleted

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS Project automatically reconfigures the schedule to show the new critical path. The critical path is shown in red and highlights the task relationships that determine a project’s finish date.
iv. Adding and Adjusting Durations

All tasks require duration estimates that may vary as a project progresses. To set a duration, click the Duration cell to the right of the task and enter the task’s estimated period and the applicable unit of time, whose abbreviations are listed below:

- Mons: months
- Wks: weeks
- Days: days
- Hrs: hours
- Mins: minutes

If the duration unit is already entered, then the duration value may be directly entered, without including the unit. Do not modify durations for parent tasks. Parent tasks are signified by a grey bar in the Gantt chart with a maximize / minimize arrow. Parent task durations are automatically calculated by their subtask durations. If a parent task duration is manually entered, select the parent task, then press the Auto Schedule button.

v. Lead and Lag Times

In defining a task relationship, a task may have to be delayed or started early.

- The **Lead** time will extend the duration and is signified with a **plus** sign.
The **Lag** time will shorten the duration and is signified with a *minus* sign.

To add a Lead or Lag time:

1. Type in the task relation type
2. Type the predecessor task number
3. Include a plus or minus sign
4. Input the amount of delay or early start

Lead time and lag time can also be set by right clicking on a task and selecting Information. On the Predecessors tab, enter the predecessor ID or Task Name, the relationship type and a positive duration for lead time or a negative duration for lag time in the Lag column.
vi. Adding Notes and Hyperlinks to a Task

a. Adding Task Notes

As stated in the Directive: “Explanations for changes in task durations are added as task notes.” Notes are reserved to clearly indicate when a specific project task duration is adjusted from the baseline. The note should be placed in the respective task’s indicator column. The note should state:

- The date of the entry.
- The person writing the note.
- Justification for the task duration adjustment
- Recipient notification (recommended)

The Recipient Notification List is subject to the project manager’s discretion. The purpose is to outline a step where project team members who may be interested or are directly impacted by a duration change are notified. Once a note is drafted and the duration is adjusted, it is recommended that a notification email be sent to the relevant recipients and that the correspondence is saved to the project’s 140_Project Administration folder in ProjectWise. The recipients may typically include:

- AEC’s project management unit: Bruce.Bourgoin@ct.gov and John.Dudzinski@ct.gov.
- Finance, such as the Office of Capital Planning.
- Design engineers in the project manager’s division.
- The group involved with the duration change or the group affected by the change. For example, if the six month estimated duration for a project survey needs to be pushed back, the survey supervisor involved with the task should be included as a recipient in the notification email.

The purpose of the recipient list is to improve communication between units and to harvest project data. AEC will collect a repository of duration change notes in order to continuously reevaluate and improve schedule templates.
To add a note, right click on a task and select Notes. Then insert the notes in the pop-up window. Another option is to access the Notes window by double clicking on the task. Then in the Task Information window, select the Notes tab.

![Image of task with right-click menu open showing Notes option highlighted]

### b. Adding Hyperlinks to a Task

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and reference documents.” For all templates, hyperlinks shall be used to link a task to a division-specific Schedule Task Library folder located in the Scheduling Directive folder.

For example, a permit task should provide a link to a corresponding ProjectWise folder that contains the permit’s regulatory document, suggested points of contact or experts, pre-written memorandums, etc. These documents must be added and actively maintained. Division SMEs and AEC Applications shall be the active maintainers of the division library modifications. It is critical that users report when a document is incorrect or has been superseded so that documents can be properly updated. While it is suggested that users coordinate with SMEs to hyperlink documents, the procedure is also provided below:

1. To add a hyperlink, right click to which a link needs to be added and select **Hyperlink**.

![Image of right-click menu showing Hyperlink option highlighted]

2. In the Insert Hyperlink window that appears, insert the web address or navigate to the correct file.
3. To remove a link, right click on the link, then select Task → Hyperlink → Edit Hyperlink → Remove Link.

4. To access a hyperlink hold the CTRL key and left click the hyperlink icon located in the Indicator column.

C. Tracking the Project

i. Baselining the Project
Each MS Project file must have a baseline set at the start of Preliminary Design. The baseline is essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of the baseline is to gauge how much a schedule varies from the initial baseline. Projects shall not be re-baselined unless there is a major scope change. Re-baselining requires Engineering Administrator approval.
To set the baseline:

1. Under the Project tab, select Set Baseline button, then Set Baseline from the drop-down.

2. In the dialog box, keep the default values for Set baseline and Entire project. Then click OK.

   ![Diagram showing steps to set baseline]

   **Click OK**

   **a. Re-baselining**

   If re-baselining is needed and is approved by the Engineering Administrator, the baseline can be set using the following steps:

   1. Go to Project → Set Baseline → Set Baseline
   2. In the Set Baseline window that appears, select Set interim plan. From the copy drop-down menu, select Baseline. From the Into drop-down menu, select Baseline10. Ensure that the Entire Project button is selected. Then press OK.
3. Go to Project → Set Baseline → Set Baseline. Keep the default values and select OK.

4. A pop-up window will appear asking, “Are you sure you want to overwrite the data in this baseline?” Click Yes.

5. After the project has been re-baselined, add a note to the top left identifier cell located in the project number row. The note should include the details outlined in the Adding Notes and Hyperlinks to a Task section. The recipient list should include all parties affected by the baseline adjustment.
6. After the project has been re-baselined, change to the Tracking Gantt view. To do this, right click in the grey Gantt Chart bar on the left side of the screen, then select Tracking Gantt.
7. The Gantt chart will show two bars stacked on top of each other. The grey bar is the baseline and the bar on top is the actual duration. If there is a slip in a task’s schedule it will be shown as an offset.

8. To change the table of tasks to the tracking mode, click on the upper left corner cell to select the entire schedule, then right click and select Tracking. The table of tasks will be in tracking mode. Click save.
ii. Recording Task Progress

The project manager will be required to record the project progress by keeping an up-to-date record of the percent complete for each task in the project. This shall be recorded in 25% increments. The following provides guidance on how to record a task’s progress:

1. Click on a task.
2. In the task menu, select the appropriate percent complete. **Note:** When the task is completed, do not select 100% complete. Rather, type in the actual finish date for that task. If the 100% complete option is selected, Microsoft Project will calculate the finish date instead of recording the actual date when the task was completed.
In the tracking Gantt, the task will show the percent complete of each task:

When a task is not started or finished on schedule, it will show as a slipping bar in the Gantt chart:
D. Generating Reports and Summaries

Microsoft Project has three reporting options:

- Standard reports
- Custom reports
- Visual reports.

i. Standard Reports

Standard Reports are reports predefined by Microsoft and include report types such as overview, current, costs, assignments and workload. To access these report options, select Project → Reports, then choose the correct report type.

Under Overview, the following is reported:

- Project summary
- Top-level tasks
- Critical tasks
- Milestones
- Working days

Under Current, the following is reported:

- Un-started tasks
- Tasks starting soon
• Tasks in progress
• Completed tasks
• Should have started tasks
• Slipping tasks.

Under Cost, the following is reported:

• Cash flow
• Budget
• Over-budget tasks
• Over-budget resources
• Earned value

Under Assignments, the following is reported:

• Who does what
• Who does what when
• To-do list
• Over-allocated resources

Under Workload the following is reported:

• Task usage
• Resource usage
ii. Custom Reports

Users can create customized reports based on templates from the following categories:

- Task
- Resource
- Monthly calendar
- Crosstab

To create a custom report:

1. Go to Projects → Reports. Then double-click on the Custom button.
2. Select a report type from the list provided. Click Edit. A Task Report dialog box will appear. Modify report settings as needed.

iii. Visual Reports

In contrast to the standard and custom reports, visual reports present information graphically. Visual reports are pre-formatted Excel pivot-tables and pivot-charts, as well as Visio pivot-diagrams.

To create a visual report:

1. Go to Projects → Visual Reports.
2. Select the preferred report type tab, then choose from the list of available templates. Click View once selection is complete.
Select the appropriate tab for your intended goal.

List of available report Templates

Then click View.
Appendix D: Processing Digital Contractor Submissions

A. Contractor Submittal Types

The three categories of Contractor submittals identified below are covered, with each being precisely defined in the Contract (e.g., Owned Special Provision). The following short-hand descriptions are provided for instructional purposes but are not the controlling definitions:

- **Shop Drawings** supplement the information in the contract documents (e.g., plans and specifications) and include details, diagrams, etc.

- **Working Drawings** portray the design of an engineered feature required by the Contract that was not designed by the Department’s Designer; Working Drawings and supporting information are prepared and stamped by a Professional Engineer serving as the Contractor’s designer.

- **Product Data (Catalog Cut)** is product information developed and made available by manufacturers, such as product specifications, diagrams, installation instructions, etc.

Although Contractors submit other materials to the Department for review, only the three categories identified above are covered in this Appendix.

B. Summary of Review Process and Roles

As parties to a contract, the Contractor and Department have specified responsibilities. This summary is an overview of the Contractor submittal review process.

Timely, coordinated and effective communications are essential to the successful and equitable completion of the Contract. Generally, the Department is required to respond to a Contractor submittal within 30 calendar days of its receipt, with 20 additional days allowed to process any necessary resubmissions. Special provisions may alter this typical timeline.

This section summarizes key points related to processing digital Contractor submissions with a focus on Department responsibilities and coordination. The following summary is intended to be an instructional overview. It is important to understand that the contract documents (i.e., included special provisions), not this summary, control the actual requirements and should be referenced for all project decisions.

- **Shop Drawings** along with supporting information (e.g., transmittal, etc.) are submitted by the Contractor to the Department’s Designer for review. Upon completion of the review and applying digital comments, the appropriate discipline (i.e., Bridge, Highway Design, Traffic Engineering) Department Designer stamps each shop drawing sheet and, at a minimum, the cover sheet of any multi-page support documents with the (digital) Action stamp. Communications between the Contractor and Department Designer (e.g., digital submittal, notification of review completion) are described in the Coordination and Communication section.
• **Working Drawings** along with supporting information (e.g., transmittal, calculations, certificates of insurance) are submitted by the Contractor to the Construction District for review. Working Drawing submissions involving structures and complex engineering (see Construction Manual for examples) should be reviewed by the Department’s Designer. When requested by the Construction District, the Department’s Designer for the appropriate discipline (i.e., Bridge, Highway Design, Traffic Engineering) reviews the submittal and stamps (with Review Stamp) each Working Drawing sheet and, at a minimum, the cover sheet of any multi-page support documents. The Department Designer should stamp the document to show the Department’s “Recommended Disposition.” The Construction District should evaluate the Designer’s comments and recommendations and meet with the Designer and/or Contractor to resolve any conflicts. After considering the Department’s Designer review comments and other pertinent information, the Construction District will make appropriate adjustments to the comments and stamp (with Action stamp) each Working Drawing sheet and cover of associated support documents. For submittals involving Construction-only review, the Construction District applies digital comments and stamps each Working Drawing sheet and, at a minimum, the cover sheet of any multi-page support documents with the (digital) Action stamp. Communications between the Contractor and Construction District and between the Construction District and Department Designer are described in the Coordination and Communication section.

• **Product Data (Catalog Cut)** is submitted by the Contractor to the Department’s Designer for review. Upon completion of the review and applying digital comments, the appropriate discipline (i.e., Bridge, Highway Design, Traffic Engineering) Designer stamps relevant portions of the submittal with the (digital) Action stamp. Communications between the Contractor and Department Designer (e.g., digital submittal, notification of review completion) are described in the Coordination and Communication section.

The Department uses Action stamps (and if appropriate, comments) to notify a Contractor of a submittal’s disposition. The precise meanings of Action stamps are defined by the specifications (i.e., special provision). The following are paraphrased definitions:

• **No Exceptions Noted** means the Department’s reviewer has not observed anything in the submittal different from what is called for by the Contract requirements and the Contractor may proceed provided that any manufacturers’ warranty called for by the Contract can be fulfilled.

• **Exceptions as Noted** means the considerations or changes noted by the Department’s reviewer are required and, after reviewing required changes, the Contractor notifies the Department’s reviewer if the changes violate a Contract provision or lessen any warranties. The Contractor may proceed with the work covered in in the submittal.

• **Revise and Resubmit** means the Department’s reviewer has identified and noted statements or features that appear different from what the Contract requires. The Contractor is required to revise the submittal(s), based on the reviewer’s comments, and resubmit for another review. The Department may take such additional time (typically 20 days) to review resubmissions.

• **Rejected** means the Department’s reviewer has identified and noted one or more statements or features that are different from what the Contract requires. The Contractor is required to revise the submittal, based on the reviewer’s comments, and resubmit for another review. The Department may take such additional time (typically 20 days) to review resubmissions.
Review stamps, as opposed to Action stamps, are used for intra-Department (including Department consultant Designers) coordination. Specifically, review stamps are used by Department Designers when requested by a Construction District to review Working Drawings. Review stamps have the following meanings.

- **Reviewed, No Comments** means the Department’s Designer has reviewed the submittal and takes no exception. The associated Recommended Disposition (in the Working Drawing Response Memo) is No Exceptions Noted.

- **Reviewed with Comments** means the Department’s Designer has reviewed the submittal and identified concerns. The associated Recommended Disposition (in the Working Drawing Response Memo) is one of the following: Exceptions as Noted, Revise and Resubmit or Rejected.

Working Drawings reviewed by the Department’s Designer are returned to the Contractor with two stamps. The Department Designer applies the Review stamp first and then the Construction District applies the Action stamp.

The application of Review and Action stamps is summarized in the tables below.

**PARTY RESPONSIBLE FOR STAMPING CONTRACTOR SUBMITTALS**

<table>
<thead>
<tr>
<th>Stamp</th>
<th>Submission Category</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Shop Drawings</td>
</tr>
<tr>
<td>Action</td>
<td>Department’s Designer</td>
</tr>
<tr>
<td>Review (Optional)</td>
<td>--</td>
</tr>
</tbody>
</table>
### DESCRIPTIONS OF COMMON STAMP USAGE

<table>
<thead>
<tr>
<th>Type</th>
<th>Facsimile</th>
<th>As Used By</th>
<th>Description of Typical Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td></td>
<td>Department’s Designer</td>
<td>Department’s Designer reviews submittal (shop drawings, product data), makes applicable comments, applies stamp and responds to Contractor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><img src="image" alt="Action Stamp" /></td>
</tr>
<tr>
<td>Review</td>
<td></td>
<td>Department’s Designer</td>
<td>When requested by Construction District, Department’s Designer reviews working drawing submittal, notes any comments, applies stamp and transmits response, including Working Drawing Response Memo to Construction District.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><img src="image" alt="Designer’s Review" /></td>
</tr>
<tr>
<td>Action</td>
<td></td>
<td>Construction District</td>
<td>Construction District evaluates submittal (Working Drawings), determines if review by the Department’s Designer is needed, evaluates submittal, resolves any Department’s Designer comments, makes / adjusts applicable comments, applies stamp and responds to the Contractor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><img src="image" alt="Action Stamp" /></td>
</tr>
</tbody>
</table>


### C. Coordination and Communication

COMPASS facilitates efficient communication between the Contract parties as summarized below.

- **Submittals by Contractors:** When the Contractor uploads submittals using the COMPASS S&T Application, appropriate Department staff and consultants will receive an auto-generated email notification and be able to access the following information directly in COMPASS:
  - Project number and town (e.g., Project No. 0015-0999, Bridgeport)
  - Project description (e.g., I-95 over Metro-North Railroad)
  - Submittal type (e.g., Shop Drawing, Working Drawing, Product Data)
  - Submittal description
List of documents included in the submittal

- **Acknowledging receipt of submittals:** The Contractor’s submittal will populate in the Submittals / Transmittals table as soon as the submission is processed. This serves as acknowledgment of receipt.

- **Intra-Department Coordination (For Working Drawings):** If the Construction District determines a Department Designer review of a working drawing submittal is necessary, COMPASS is used to request the review. The Department’s Designer responds to the Construction District using COMPASS.

- **Conclusion and Response:** When the Department’s review is complete, including placement of an Action stamp, an automated email notification is sent to the Contractor and the S&T table updates the Review Status.

Each participant (e.g., submitter, reviewer, etc.) is required to use the COMPASS S&T tool.

**D. Process Conclusion**

The Contractor must make the required corrections and repeat the submittal procedures until all the submittals are stamped as “No Exceptions Noted” or “Exceptions as Noted.”

After a submittal has been stamped with “No Exceptions Noted” or “Exceptions as Noted” the Contractor is required to provide paper copies, either as specified or as directed.
Appendix E: Bluebeam 2016 Integration

To set-up the SharePoint / Internet Explorer integration using Bluebeam 2016:

1. From the Start menu, open Bluebeam Administrator 2016.

2. Select the Revu tab

3. Check the box to Display PDF in Internet Explorer

4. Select Apply

5. Select OK to close the Bluebeam Administrator window
6. After setting up the PDF settings, use Internet Explorer to navigate to the correct submittal in the Submittals/Transmittals table.

7. Select the preferred PDF submittal document.

8. The PDF will open in an Internet Explorer viewer.

9. Select the Bluebeam Revu button in the menu bar.
10. A window may display, indicating that Bluebeam Revu is Communicating with SharePoint (COMPASS pages).

11. A Microsoft sign-in window will appear. Input the same Office 365 / Microsoft Online Sign-In information used to access COMPASS.

12. A window titled SharePoint Open from Web Browser will appear. Select the Check Out & Open button.
13. The document will open in Bluebeam Revu. The user can then edit, mark-up, scrub or digitally sign the document as needed. Previous versions of the document are preserved by COMPASS’s Version Control feature.

14. When complete, press save.

15. Close the document by closing the individual Bluebeam tab or closing the entire Bluebeam program.

16. A window titled Close SharePoint Document will appear. *Note: Comments inputted in this window will not be provided to the Submitter / Contractor. Comments intended for the Submitter / Contractor must be added to the PDF document itself or inputted in the COMPASS Comment Pop-Up Windows.*

17. Select the Check In button to save any changes. Press Release Checkout if no changes are made.

18. A new version saves in COMPASS. The previous version(s) are preserved through COMPASS’s Version Control feature.